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Read this manual carefully before you use this machine and keep it handy for future reference. For safe and correct use, be sure to read the
Safety Information in the "General Settings Guide" before using the machine.

Introduction
This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.
Important
Contents of this manual are subject to change without prior notice. In no event will the company be liable for direct, indirect, special, incidental, or consequential damages as a result of handling or operating the machine.
Trademarks
Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.
Adobe® and PostScript® are registered trademarks of Adobe Systems Incorporated.
Apple, AppleTalk, EtherTalk, Macintosh, Mac OS and TrueType are trademarks of Apple Computer,
Inc, registered in the United States and other countries.
Rendezvous is a trademark of Apple Computer Inc.
Bluetooth® is a registered trademark of Bluetooth-SIG Inc. worldwide.
Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.
The proper names of the Windows operating systems are as follows:
•

The product name of Windows® 95 is Microsoft® Windows 95.

•

The product name of Windows® 98 is Microsoft® Windows 98.

•

The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

•

The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional

•

The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

•

The product names of Windows ServerTM 2003 are as follows:
Microsoft® Windows ServerTM 2003 Standard Edition
Microsoft® Windows ServerTM 2003 Enterprise Edition

•

The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

•

Microsoft® Windows NT® Workstation 4.0

Notes:
Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.

TABLE OF CONTENTS
1. Windows Configuration
Using the SmartDeviceMonitor for Client Port....................................................1
Installing SmartDeviceMonitor for Client ....................................................................1
Installing the PostScript 3 Printer Driver (Windows 95 / 98 / Me - TCP/IP)................2
Installing the PostScript 3 Printer Driver (Windows 95 / 98 / Me - IPP) .....................3
Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)...........................5
Installing the PostScript 3 Printer Driver (Windows 2000 - IPP) ................................6
Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003 - TCP/IP) ...7
Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003 - IPP)...8
Installing the PostScript 3 Printer Driver (Windows NT 4.0 - TCP/IP)......................10
Installing the PostScript 3 Printer Driver (Windows NT 4.0 - IPP)............................11
Changing the Port Settings for SmartDeviceMonitor for Client ................................ 12
Using the Standard TCP/IP Port .........................................................................14
Installing the PostScript 3 Printer Driver (Windows 2000) .......................................14
Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003) .....15
Using the LPR Port ..............................................................................................17
Installing the PostScript 3 Printer Driver (Windows 2000) .......................................17
Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003) .....18
Installing the PostScript 3 Printer Driver (Windows NT 4.0).....................................19
Using as the Windows Network Printer .............................................................21
Installing the PostScript 3 Printer Driver (Windows 95 / 98 / Me) ............................21
Installing the PostScript 3 Printer Driver (Windows 2000) .......................................22
Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003) .....23
Installing the PostScript 3 Printer Driver (Windows NT 4.0).....................................24
Using as the NetWare Print Server / Remote Printer........................................26
When using the PostScript 3 Printer Driver..............................................................26
Installing the Printer Driver Using USB .............................................................27
Windows 98 SE / Me - USB .....................................................................................27
Windows 2000 - USB ...............................................................................................29
Windows XP, Windows Server 2003 - USB .............................................................30
Troubleshooting for using USB ................................................................................31
Printing with Parallel Connection.......................................................................32
Installing the PostScript 3 Printer Driver (Windows 95 / 98 / Me) ............................32
Installing the PostScript 3 printer driver (Windows 2000) ........................................33
Installing the PostScript 3 Printer Driver (Windows XP, Windows Server 2003) .....34
Installing the PostScript 3 Printer Driver (Windows NT 4.0).....................................35
Installing the Printer Driver Using IEEE 1394 (SCSI print)...............................36
Windows 2000..........................................................................................................36
Windows XP, Windows Server 2003........................................................................38
Printing with Bluetooth Connection...................................................................40
Supported Profiles....................................................................................................40
Printing with Bluetooth Connection .......................................................................... 40
If a Message Appears during Installation ..........................................................43
Making Option Settings for the Printer ..............................................................44

i

Setting Up the Printer Driver...............................................................................45
Windows 95 / 98 / Me - Accessing the Printer Properties ........................................45
Windows 2000 - Accessing the Printer Properties ...................................................47
Windows XP, Windows Server 2003 - Accessing the Printer Properties .................49
Windows NT 4.0 - Accessing the Printer Properties ................................................51

2. Mac OS Configuration
Mac OS..................................................................................................................53
Installing the PostScript 3 Printer Driver and PPD File ............................................53
Setting Up PPD Files ...............................................................................................54
Setting Up Options ...................................................................................................55
Installing Adobe Type Manager ...............................................................................55
Installing Screen fonts..............................................................................................56
Changing to EtherTalk .............................................................................................57
Mac OS X ..............................................................................................................58
Installing the PPD Files ............................................................................................58
Setting Up the PPD File ........................................................................................... 58
Setting Up Options ...................................................................................................59
Using USB Interface.................................................................................................59
Using Rendezvous ...................................................................................................60
Changing to EtherTalk .............................................................................................60
Configuring the Printer........................................................................................61

3. Using PostScript 3
Setting Up Options ..............................................................................................63
Printing a Document............................................................................................64
Job Type ..................................................................................................................64
User Code ................................................................................................................97
Paper Selection........................................................................................................97
Paper Size................................................................................................................98
Fit to Paper...............................................................................................................98
Input Slot ..................................................................................................................99
Resolution ................................................................................................................99
Print Mode (Toner Saving ) ....................................................................................100
Duplex Printing....................................................................................................... 100
Gradation ...............................................................................................................102
Collate ....................................................................................................................103
Paper Type.............................................................................................................104
Destination Tray .....................................................................................................104
Staple ..................................................................................................................... 105
Punch ..................................................................................................................... 105
Watermark..............................................................................................................106
Watermark Text......................................................................................................106
Watermark Font .....................................................................................................106
Watermark Size......................................................................................................107
Watermark Angle ...................................................................................................107
Watermark Style.....................................................................................................108
Dithering.................................................................................................................108
Image Smoothing ...................................................................................................109

ii

4. Printer Utility for Mac
Installing Printer Utility for Mac........................................................................111
Starting Printer Utility for Mac ..........................................................................112
Mac OS .................................................................................................................. 112
Mac OS X...............................................................................................................112
Printer Utility for Mac Functions ......................................................................113
Downloading PS Fonts...........................................................................................114
Displaying Printer's Fonts.......................................................................................115
Deleting Fonts ........................................................................................................115
Initializing the Printer Disk...................................................................................... 116
Page Setup ............................................................................................................116
Printing Fonts Catalog............................................................................................116
Printing Fonts Sample............................................................................................117
Renaming the Printer .............................................................................................117
Restarting the Printer .............................................................................................118
Downloading PostScript Files ................................................................................118
Selecting the Zone .................................................................................................119
Displaying the Printer Status..................................................................................120
Launching the Dialogue Console ........................................................................... 120

INDEX....................................................................................................... 121

iii

iv

1. Windows Configuration
Using the SmartDeviceMonitor for Client Port
Installing SmartDeviceMonitor for Client
Important
❒ To install SmartDeviceMonitor for Client under Windows 2000/XP Professional, Windows Server 2003, and Windows NT 4.0, you must have an account that has Manage Printers permission. Log on as an Administrator.
❒ Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.

D Click [SmartDeviceMonitor for Client/Admin].
E The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [I accept the agreement.], and
then click [Next >].

F The SmartDeviceMonitor for Client installer starts.
G Click the [SmartDeviceMonitor for Client] checkbox, and then click [Next >].
The SmartDeviceMonitor for Client installer starts.

H Follow the instructions on the display to install SmartDeviceMonitor for
Client.

I Click [Finish].
If you are required to restart the computer after installing SmartDeviceMonitor for Client, restart the computer.
Note
❒ To stop installation of the selected software, click [Cancel] before installation is complete. Restart the computer and reinstall other programs or
printer drivers.
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Installing the PostScript 3 Printer Driver (Windows 95 / 98 / Me - TCP/IP)

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.

1

The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [Local Printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the machine whose driver you want to install, and then
click [Next >].

H In the [Available ports:] box, click [Printer Port], and then click [Next >].
I Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

J Specify whether or not to print a test page, and then click [Finish].
K On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

L Click the icon of the printer you want to use. On the [File] menu, click [Properties].

M On the [Details] tab, click [Add Port…].
N Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].
O Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.
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Using the SmartDeviceMonitor for Client Port

P Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], enter the IP address or host
name of the machine, and then click [OK].
You cannot add an IP address partially similar to the one already used. For
example, if “192.168.0.2” is in use, “192.168.0.2xx” cannot be used. Similarly,
if “192.168.0.20” is in use, “192.168.0.2” cannot be used.
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Q Check that the selected port is highlighted in [Print to the following port], and
then click [OK].

R Restart the computer to complete installation.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows 95 / 98 / Me - IPP)

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [Local Printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the machine whose driver you want to install, and then
click [Next >].

H In the [Available ports:] box, click [Printer Port], and then click [Next >].
3
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I Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

J Specify whether or not to print a test page, and then click [Finish].
K On the [Start] menu, point to [Settings], and then click [Printers].
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The [Printers] window appears.

L Click the icon of the printer you want to use. On the [File] menu, click [Properties].

M On the [Details] tab, click [Add Port…].
N Click [SmartDeviceMonitor] in the [Other] list, and then click [OK].
O Click [IPP].
P In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-

er's address.
If the server authentification is issued, to enable SSL ( a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Explorer 5.01, or a higher version must be installed).
(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer
You can enter "http://printer's address/ipp" as the printer's address.

Q Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port name.

R Click [Detailed Settings] to configure proxy server, IPP user name, and other
settings. Make these settings, and then click [OK].
You can enter "http://printer's address/ipp" as the printer's address.

S Click [OK].
T Check that the selected port is highlighted in [Print to the following port], and
then click [OK] .

U Restart the computer to complete installation.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)
Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.

The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.

Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [Local printer], and then click [Next >].
G Click [Create a new port:].
H Click [SmartDeviceMonitor], and then click [Next >].
I Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

J Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

K Check that the name of the machine whose driver you want to install is selected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

M Specify whether or not to share the printer, and then click [Next >].
N Specify whether or not to print a test page, and then click [Next >].
O Click [Finish].
The printer driver installation starts.

Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)
Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [Local printer attached to this computer], and then click [Next >].
G Click [Create a new port:].
H Click [SmartDeviceMonitor], and then click [Next >].
I Click [IPP].
J In the [Printer URL] box, enter “http://(printer's address)/printer” as the printer's address.
If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Explorer 5.01, or a higher version must be installed).
(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer
You can enter "http://printer's address/ipp" as the printer's address.

K Enter a name for identifying the printer in [IPP Port Name]. Use a name dif6

ferent from the name of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port name.

Using the SmartDeviceMonitor for Client Port

L Click [Detailed Settings] to configure proxy server, the IPP user name and other settings. Specify the necessary settings, and then click [OK].
For information about the settings, see SmartDeviceMonitor for Client Help.

M Click [OK].
N Check that the name of the machine whose driver you want to install is se-
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lected, and then click [Next >].

O Change the printer name if you want, and then click [Next >].
P Specify whether or not to print a test page, and then click [Next >].
Q Click [Finish].
The printer driver installation starts.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003 - TCP/IP)
Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.

The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe”on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.

Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [Local printer attached to this computer.], and then click [Next >].
G Click [Create a new port:].
H Click [SmartDeviceMonitor], and then click [Next >].
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I Click [TCP/IP], and then click [Search].

A list of printers using TCP/IP appears.

J Select the printer you want to use, and then click [OK].

1

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

K Check that the name of the machine whose driver you want to install is selected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

M Specify whether or not to print a test page, and then click [Next >].
N Click [Finish].
The printer driver installation starts.

Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003 - IPP)
Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.
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E Click [Next >].
F Click [Local printer attached to this computer.], and then click [Next >].

Using the SmartDeviceMonitor for Client Port

G Click [Create a new port:].
H Click [SmartDeviceMonitor], and then click [Next >].
I Click [IPP].
J In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-

1

er's address.
If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Explorer 5.01, or a higher version must be installed).
(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer
You can enter "http://printer's address/ipp" as the printer's address.

K Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port name.

L Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

M Click [OK].
N Check that the name of the printer driver you want to install is selected, and
then click [Next >].

O Change the name of the printer if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

P Specify whether or not to print a test page, and then click [Next >].
Q Click [Finish].
The printer driver installation starts.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0 - TCP/IP)
Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Select [My Computer], and then click [Next >].
F Click [Add Port...].
G Click [SmartDeviceMonitor], and then click [New Port...].
H Click [TCP/IP], and then click [Search].
A list of printers using [TCP/IP] appears.

I Select the printer you want to use, and then click [OK].
Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

J Click [Close] to close the [Printer Port] dialog box.
K Click [Next >].
L Check that the name of the machine whose driver you want to install is selected, and then click [Next >].

M Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.
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N Specify whether or not to share the printer, and then click [Next >].

Using the SmartDeviceMonitor for Client Port

O Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

P Restart the computer to complete installation if necessary.

1

Note
❒ A user code can be set after the printer driver installation . For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0 - IPP)
Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Select [My Computer], and then click [Next >].
F Click [Add Port...].
G Click [SmartDeviceMonitor], and then click [New Port...].
H Click [IPP].
I In the [Printer URL] box, enter “http://(printer's address)/printer”as the printer's address.
If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Explorer 5.01, or a higher version must be installed).
(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer
You can enter "http://printer's address/ipp" as the printer's address.
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J Enter a name for identifying the printer in [IPP Port Name]. Use a name different from the one of any existing port.
If a name is not specified here, the address entered in the [Printer URL] box becomes the IPP port name.

1

K Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

L Click [OK].
M Click [Close] to close the [Printer Port] dialog box.
N Click [Next >].
O Check that the name of the machine whose driver you want to install is selected, and then click [Next >].

P Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

Q Specify whether or not to share the printer, and then click [Next >].
R Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

S Restart the computer to complete installation if necessary.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Changing the Port Settings for SmartDeviceMonitor for Client
Follow the procedure below to change the SmartDeviceMonitor for Client settings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Windows 95 / 98:

A Open the [Printers] window from the [Start] menu.
B In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

C
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Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.

Using the SmartDeviceMonitor for Client Port

Windows 2000 / Windows NT 4.0:

A Open the [Printers] window from the [Start] menu.
B In the [Printers] window, click the icon of the printer you want to use. On

1

the [File] menu, click [Properties].

C On the [Ports] tab, click [Configure Port]
The [Port Configuration] dialog box appears.

Windows XP, Windows Server 2003:

A Open the [Printers and Faxes] window from the [Start] menu.
The [Printers and Faxes] window appears.

B Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

C

Click the [Port] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.
• For TCP/IP, timeout setting can be configured.
Note
❒ If no settings on the [Recovery/Parallel Printing] tab are available, follow
the procedure below.
A

Click [Cancel] to close the [Port Configuration:] dialog box.
B Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Client icon on the taskbar.
C Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each port] check box.
D Click [OK] to close the [Extended Features Settings] dialog box
• User, proxy, and timeout settings can be configured for IPP.
Reference
For information about these settings, see SmartDeviceMonitor for Client
Help.
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Using the Standard TCP/IP Port
Installing the PostScript 3 Printer Driver (Windows 2000)

1

Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [Local printer], and then click [Next >].
G Click [Create a new port:].
H Click [Standard TCP/IP Port], and then click [Next >].
I Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
J Enter the printer name or IP address in the [Printer Name or IP Address] box,
and then click [Next >].
When screen for Device selection appears, select "RICOH NetworkPrinter
Driver C Model".

K Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
L Check that the name of the machine whose driver you want to install is selected, and then click [Next >].

M Change the printer name if you want, and then click [Next >].
14

Select the [Yes] check box to configure the printer as default.

Using the Standard TCP/IP Port

N Click [Next >].
O Specify whether or not to print a test page, and then click [Next >].
P Click .

1

The printer driver installation [Finish]starts.
Note
❒ A user code can be set after the printer driver installation . For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)
Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [Local printer attached to this printer], and then click [Next >].
G Click [Create a new port:].
H Click [Standard TCP/IP Port] in [Create a new port], and then click [Next >].
I Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
15
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J Enter the printer name or IP address in the [Printer Name or IP Address] box,
and then click [Next >].
When screen for Device selection appears, select "RICOH NetworkPrinter
Driver C Model".

1

K Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
L Check that the name of the machine whose driver you want to install is selected, and then click [Next >].

M Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

N Specify whether or not to print a test page, and then click [Next >].
O Click [Finish].
The printer driver installation starts.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using the LPR Port
Installing the PostScript 3 Printer Driver (Windows 2000)

1

Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [Local printer], and then click [Next >].
G Click [Create a new port:].
H Click [LPR Port], and then click [Next >].
I Enter the printer's IP address in the [Name or address of server providing lpd] box.
J Enter “lp” in the [Name of printer or print queue on that server] box, and then click [OK].
K Check that the name of the machine whose driver you want to install is selected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

M Click [Next >].
N Specify whether or not to print a test page, and then click [Next >].
O Click [Finish].
The printer driver installation starts.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)

1

Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory."

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Select [My Computer], and then click [Next >].
F Click [Local Printer attached to this computer.], and then click [Next >].
G Click [Create a new port:].
H Click [LPR Port] in [Create a new port], and then click [Next >].
I Enter the printer's IP address in the [Name or address of server providing lpd] box.
J Enter “lp” in the [Name of printer or print queue on that server box], and then click [OK].
K Check that the name of the machine whose driver you want to install is selected, and then click [Next >].

L Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

M Click [Next >].
N Specify whether or not to print a test page, and then click [Next >].
O Click [Finish].
The printer driver installation starts.
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Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Using the LPR Port

Installing the PostScript 3 Printer Driver (Windows NT 4.0)
Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Select [My Computer], and then click [Next >].
F Click [Add Port...].
G Select [LPR Port], and then click [New Port...].
H Enter the printer's IP address in the [Name or address of server providing lpd] box.
I Enter “lp” in the [Name of printer or print queue on that server:] box, and then
click [OK].

J Click [Close] to close the [Printer Port] dialog box.
K Click [Next >].
L Check that the name of the machine whose driver you want to install is selected, and then click [Next >].

M Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.
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N Specify whether or not to share the printer, and then click [Next >].
O Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

1

P Restart the computer to complete installation if necessary.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using as the Windows Network Printer
Installing the PostScript 3 Printer Driver (Windows 95 / 98 / Me)

1

Important
❒ If you print from a print server connected to the printer using the SmartDeviceMonitor port, the client cannot use Recovery Printing and Parallel Printing.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [Network printer], and then click [Next >].
G Click [Browse].
H Click the computer name you want to use as a print server in the [Browse for
Printer] window.

I Select the printer you want to use, and then click [OK].
J Check the location of the selected printer is shown, and then click [Next >].
K Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

L Specify whether or not to print a test page, and then click [Finish].
M Restart the computer.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows 2000)
Important
❒ Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

1

❒ If you print from a print server connected to the printer using the SmartDeviceMonitor port, the client cannot use Recovery Printing and Parallel Printing.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [Network printer], and then click [Next >].
G Select the location method from the [Locate Your Printer] screen, and then
click [Next >].

H Double-click the computer name you want to use as a print server in the
[Shared printers] window.

I Select the printer you want to use, and then click [Next >].
J The printer driver installation starts.
K Click [Next >].
Select the [Yes] check box to configure the printer as default.

L Click [Finish].
Restart the computer to complete installation.
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Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Using as the Windows Network Printer

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)

1

Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

❒ If you print from a print server connected to the printer using the SmartDeviceMonitor port, the client cannot use Recovery Printing and Parallel Printing.
❒ If you print with a Windows XP or Windows Server 2003 print server, SmartDeviceMonitor notification functions may not be possible for the client.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [A network printer, or a printer attached to another computer] and then click
[Next >].

G Select [Browse for a printer], and then click [Next >].
H Double-click the computer name you want to use as a print server in the
[Shared printers] window.

I Select the printer you want to use, and then click [Next >].
J The printer driver installation starts.
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K Click [Next >].
Select the [Yes] check box to configure the printer as default.

L Click [Finish].

1

Restart the computer to complete installation.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0)
Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.
❒ If you print from a print server connected to the printer using the SmartDeviceMonitor port, the client cannot use Recovery Printing and Parallel Printing.
❒ To print from a Windows NT 4.0 print server, install the printer driver before
you connect the print server to the printer.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Network printer server], and then click [Next >].
F Click [Next >].
G Double-click the computer name you want to use as a print server in the
[Shared printers] window.
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H Select the printer you want to use, and then click [Next >].
I Check the location of the selected printer is shown, and then click [Next >].
J Change the printer name if you want, and then click [Next >].
K Specify whether or not to print a test page, and then click [Finish].

1

Restart the computer to complete installation.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using as the NetWare Print Server / Remote
Printer
1

When using the PostScript 3 Printer Driver
Follow the procedure below to set up the PostScript 3 printer driver.

A In the [Printers] or [Printers and Faxes] window, open the printer properties.
B Click the [PostScript] tab.
Note
❒ When using Windows 2000 / XP or Windows NT 4.0, click the [Device Settings] tab, and then proceed to step to clear the check box.

C Click [Advanced].
D Clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes, and
then click [OK].

E Click [OK] to close the printer properties dialog box.
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Installing the Printer Driver Using USB
This section explains how to install printer drivers using USB.

1

Important
❒ Make sure that machine is connected to the computer's USB ports using the
USB interface cable.

Before installing, check that only the operating system is running on the computer and no print jobs are in progress.
The printer drivers can be installed from the CD-ROM provided with this machine.

Windows 98 SE / Me - USB
Important
❒ Installation via USB is not possible under Windows 95 / 98. Upgrade to Windows 98 SE / Me.
When USB is first used, the plug and play function starts and the [New Hardware
Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, depending on the operating system.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

A Turn off the power of the machine.
B Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

C Turn on the power of the machine.
D Click [Next >].
E Click [Search for the best driver for your device. {Recommended}.], and then click
[Next >].

F Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

G Insert the CD-ROM into the CD-ROM drive.
Note
❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.
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H Specify the location where USB Printing Support is located, and then click
[Next >].
If the CD-ROM drive is D, the source files of USB Printing Support are stored
in the following location:
D:\DRIVERS\RPCS\WIN9X_ME

1

I Check the location, and then click [Next >].
USB Printing Support is installed.

J Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB001" port is added to the [Printers] window.

K Click [Next >].
L Click [Search for the best driver for your device. {Recommended}.], and then click
[Next >].

M Select the [Specify a location:], check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

N Insert the CD-ROM into the CD-ROM drive.
Note
❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

O Specify the location where the source files of the printer driver is stored,
and then click [Next >].
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• PostScript 3
D:\DRIVERS\PS3\WIN9X_ME\(Language)\DISK1

P Check the location, and then click [Next >].
Add Printer Wizard starts.

Q Click [Finish].
Installation is complete. If installation is successful, the icon of the printer
connected to the "USB001" port is added to the [Printers] window.
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Note
❒ The number after "USB" varies depending on the number of printers connected.
❒ It is not necessary to reinstall USB Printing Support when connecting a different machine via USB interface when USB Printing Support is installed.
❒ After installing USB Printing Support, if the printer driver is not installed,
follow the plug-and-play instructions of the printer.

Installing the Printer Driver Using USB

Windows 2000 - USB
Important
❒ Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

1

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

A Turn off the power of the machine.
B Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

C Turn on the power of the machine.
D Click [Next >] in the [Found New Hardware Wizard] dialog box.
E Select the [Search for a suitable driver for my device (recommended)] check box,
and then click [Next >].

F Select the [Specify location] check box, and then click [Next >].
G Insert the CD-ROM into the CD-ROM drive.
Note
❒ When Auto Run starts, click [Exit].

❒ To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

H Specify the location where the source files of the printer driver is stored.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1

I Check the printer driver location, and then click [OK].
J Click [Next >].
K Click [Finish].
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB001" port is added to the [Printers] window.
Note
❒ The number after “USB” varies depending on the number of printers connected.
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Windows XP, Windows Server 2003 - USB
Important
❒ Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

1

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.
If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.
The printer drivers can be installed from the CD-ROM provided with this machine.
If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

A Turn off the power of the machine.
B Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

C Turn on the power of the machine.
D In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended] ], and then click [Next >].

E To disable Auto Run, press the left {Shift} key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

Note
❒ If Auto Run starts, click [Cancel], and then [Exit].

F Select the [Include this location in the search] check box under [Search for the best

driver in these location], and then click [Browse] to select the printer driver location.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1

G Check the printer driver location, and then click [Next >].
H Click [Continue].
I Click [Finish].
If installation is successful, the icon of the printer connected to the "USB001"
port is added to the [Printers] window.
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Note
❒ The number after “USB” varies depending on the number of printers connected.

Installing the Printer Driver Using USB

Troubleshooting for using USB
Problems

Solutions

1

The machine is not automatically rec- Turn off the power of the machine, reconnect the USB
ognized.
cable, and then turn it on again.
Windows has already configured the
USB settings.

Open Windows' Device Manager, and then, under [Universal Serial Bus controllers], remove any conflicting devices. Conflicting devices have a yellow [!] or [?] icon by
them. Take care not to accidentally remove required devices. For details, see Windows Help.

Note
❒ When using Windows 2000/XP or Windows Server
2003, an erroneous device is displayed under [USB
Controller] in the [Device Manager] dialog box.
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Printing with Parallel Connection
To use a machine connected using a parallel interface, click [LPT1] when installing the printer driver.

1

Installing the PostScript 3 Printer Driver (Windows 95 / 98 / Me)

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [Local printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the machine whose printer driver you want to install,
and then click [Next >].

H In the [Available ports:] box, click [Printer Port], and then click [Next >].
I Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

J Specify whether or not to print a test page, and then click [Finish].
K Restart the computer to complete installation.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 printer driver (Windows 2000)
Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [Local printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select [LPT1] at the [Printer Port] dialog box, and then click [Next >].
H Select whether or not to share the printer, and then click [Next >].
I Select the name of the machine whose driver you want to install, and then
click [Next >].

J Select whether or not you want to print a test page, and then click [Finish].
The printer driver installation starts.

K Restart the computer to complete installation if necessary.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)

1

Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Click [Next >].
F Click [Local printer attached to this computer], and then click [Next >].
G Select the port you want to use, and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

H Select the name of the machine whose driver you want to install, and then
click [Next >].

I Click [Close] to close the [Printer Port] dialog box.
J Click [Next >].
K Change the printer name if you want, and then click [Next >].
L Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

M Restart the computer to complete installation.
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Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

Printing with Parallel Connection

Installing the PostScript 3 Printer Driver (Windows NT 4.0)
Important
❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.

1

A Quit all applications currently running.
B Insert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

C Select an interface language, and then click [OK].
The default interface language is English.
Note
❒ The printer driver with the selected language will be installed. The printer
driver will be installed in English if you select the following languages:
Cestina, Magyar, Polski, Portugues, Suomi.

D Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

E Select [My Computer], and then click [Next >].
F Select the port you want to use, and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

G Select the name of the machine whose driver you want to install, and then
click [Next >].

H Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

I Specify whether or not to share the printer, and then click [Next >].
J Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

K Restart the computer to complete installation if necessary.
Note
❒ A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Installing the Printer Driver Using IEEE 1394
(SCSI print)
1

The printer drivers can be installed from the CD-ROM provided with this machine.
Important
❒ Quit all applications currently running, and do not print during installation.

❒ Do not connect IEEE 1394 or USB devices to the computer or turn on another
printers during installation.
❒ Before uninstalling the printer driver, check that the IEEE 1394 interface cable
is disconnected from the computer.
❒ SCSI print must be set to "active" from the control panel. For details, see Network Guide.
❒ This machine can receive print data from one computer at a time only. An
message may appear if jobs from different computers collide.
❒ If jobs collide, the first received is printed first.
❒ When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

Windows 2000
Note
❒ If [Found New Hardware Wizard] appears every time the computer is started or
the cable is connected, disable the device. To install another printer driver after setting the "1394_00n" port, click [1394_00] as a port during the printer
driver installation.

❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.
❒ The optional 1394 interface unit can be used only with Service Pack 1 (SP1) or
higher.

A Connect the machine and computer using the IEEE 1394 interface cable.
B Click [Next >] in the [Found New Hardware Wizard] dialog box.
C When the message "This wizard will complete the installation for this Device: Unknown" appears, click [Specify a location], and then click [Next >].

D When the message "Locate Driver Files" appears, select the [Optional search
locations.] check box, and then click [Specify a location], and then click [Next >].

E To disable Auto Run, press the left {Shift} key when inserting the CD-ROM
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into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.
If Auto Run starts, click [Cancel], and then [Exit].

Installing the Printer Driver Using IEEE 1394 (SCSI print)

F Click [Browse].
G Select the printer driver you want to use.
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1\

1

H Click [Open].
I Click [OK].
J Follow the instructions.
When installation is complete, the printer connected to "1394_00n" appears in
the [Printers] window. ("n" shows the number of printers connected.)
Note
❒ If the printer driver has already been installed, the printer icon is added to
the [Printers] window. In this case, printer driver installation is not necessary.
❒ If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see "Printer Does Not Print", Maintenance Guide.
❒ If you do not want to install the printer when Found New Hardware Wizard starts under an operating system that supports SCSI print, disable the
device by following the procedure below.
A When the [Found New Hardware Wizard] dialog box appears, click [Next >].
B When the message "This wizard will complete the installation for this
Device: Unknown" appears, select the [Search for a suitable driver for my device recommended] check box, and then click [Next >].
C When the message "Please choose your search and installation option."
appears, clear all check boxes from [Search for the best driver in these locations.], and then click [Next >].
D When the message "Driver Files Search Results" appears, select the [Disable the device. The Add/Remove Hardware Wizard in the control Panel can be
able to complete the driver installations.] check box, and then click [Finish]."
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Windows XP, Windows Server 2003
Important
❒ SCSI print must be set to "active" from the control panel. For details, see Network Guide.

1

❒ Installing this printer driver requires Administrators permission. Log on using an account that has Administrators permission.
Note
❒ This machine can receive print data from one computer at a time only. If a job
from a computer collides with other data, a message may appear on the computer.
❒ To install another printer driver after setting the "1394_00n" port, click
[1394_00] as a port during the printer driver installation.
❒ When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

A Connect the machine and computer using the IEEE 1394 interface cable.
When the [Found New Hardware Wizard] dialog box appears, check that [This wizard helps you install software for: (Unknown)] is displayed.

B Select the [Install from a list on specific location (Advanced)] check box, and then
click [Next >].

C When the message "Please choose your search and installation option." ap-

pears, select the [Search for the best driver in these locations.] check box, select
the [Include this location in the search:] check box, and then select the [Include
this location in the search:] check box.

D To disable Auto Run, press the left {Shift} key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

Note
❒ If Auto Run starts, click [Cancel], and then [Exit].

E Specify the location where the source files of the printer driver is stored,

and then click [Next >].
If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:
• PostScript 3
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1\
When installation is complete, the printer connected to "1394_00n" appears in
the [Printers and Faxes] window. ("n" shows the number of printers connected.)
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F Follow the instructions.
Note
❒ If the printer driver has already been installed, the printer icon is added to
the [Printers and Faxes] window. In this case, printer driver installation is
not necessary.

1

❒ Even if the printer driver is already installed, the message " Found New
Hardware Wizard" may appear when the machine and the computer are
connected using the IEEE 1394 interface cable for the first time. If it does,
install the printer driver.
❒ If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see "Printer Does Not Print", Maintenance Guide.
❒ If you do not want to install the printer when Found New Hardware Wizard starts under an operating system that supports SCSI print, disable the
device by following the procedure below
A When the [Found New Hardware Wizard] dialog box appears, check that
[This wizard helps you install software for: Unknown] displayed, select [Install
from a list on specific location (Advanced)] check box, and then click [Next >].
B When the message "Please choose your search and installation option."
appears, clear all check boxes from [Search for the best driver in these locations.], and then click [Next >].
C When the message "The wizard could not find the software on your
computer for.." appears, click [OK].
D When the message "Cannot Install this Hardware" appears, select the
[Don't prompt again to install the software] check box, and then click [Finish].
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Printing with Bluetooth Connection
Supported Profiles

1

❖ SPP, HCRP
• A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.
• When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is selected. When selecting the connection between the other devices, cancel
the first established connection.
• Conditions for bidirectional communications
• SPP connection does not support bidirectional communications.
• HCRP connection supports bidirectional communications.
❖ BIP
• For BIP connection, a module including PostScript 3 must be installed in
the machine.
• Only one Bluetooth adaptor or Bluetooth-equipped computer can be connected via BIP.
• Only JPEG images that can be printed using BIP.
• User codes are disabled for BIP.
You cannot print if print functions are restricted.
• Some printers do not support BIP.

Printing with Bluetooth Connection
To install the printer driver, follow the procedure used to install parallel interface.
Important
❒ To install the printer driver under Windows 2000/XP Professional or Windows Server 2003, you must have an account that has Manage Printers permission. Log on as an Administrator or Power Users group member.
Note
❒ System requirements vary depending on the Bluetooth standard and specifications. For details, see the manuals provided with each product.

❒ For information about setting up Bluetooth under other operating systems or
using it with different utilities, see the manuals provided with those operating systems or utilities.
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A Start 3Com Bluetooth Connection Manager.
B Check that the printer you want to use appears in 3Com Bluetooth Connection Manager.

C On the [Tool] menu, click [COM port].
D Check that the message "Bluetooth Serial Client (COMx) " appears under

1

Client Ports. (X indicates the COM port number used by Bluetooth.)

E Click [Close].
F On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

G Click the icon of the printer you want to use.
H On the [File] menu, click [Properties].
I Click the [Ports] tab.
J Under [Port], select the [COMx:] check box.

X indicates the COM port

number used by Bluetooth.

K Click [OK].
Close the [Printers] window.

❖ If a dialog box appears while transmitting a print job, reestablish network connection as follows:
A Select the printer you want to use in the [Printers and Fax] box.
B Click [Connect].
Note
❒ To always use the same printer, select the [Always use for this connection]
check box.
Reference
For details, see the manuals provided with the Bluetooth adaptor or
computer equipped with Bluetooth.
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Configuring Security Mode Settings

A Start 3Com Bluetooth Connection Manager.
B On the [Tools] menu, click [Security Mode].

1

The [Security Mode] dialog box appears.

C Select the security mode in the [Security Mode:] list.
If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the password, see p.42 “Printing in the Security Mode”
For all other security modes and custom settings, no password is required.
Note
❒ For information about each mode, see the manuals provided with the utility.

D Click [OK].
Close the [Security Mode] dialog box.
Reference
For details about the security mode, see 3Com Bluetooth Connection Manager Help. For details about the password entry which is required to transmit print jobs, see p.42 “Printing in the Security Mode”.

Printing in the Security Mode

A Send the print job to the printer in use.
Depending on the computer configuration, the [Connect] dialog box may appear. If it does, use it to establish the network connection.

B The [Authentication] dialog box appears.
C Enter the Bluetooth password, and then click [OK].
As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label on the back of the machine. For example, if the serial number is 00A0-001234, the Bluetooth password is 1234.

D The print job is sent.
Note
❒ The Bluetooth password differs for each machine and cannot be changed.
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If a Message Appears during Installation
Message number 58 or 34 indicates the printer driver cannot be installed using
Auto Run. Install the printer driver using [Add Printer] or [Install Printer].

1

For Windows 95 / 98 / Me, Windows 2000 and Windows NT 4.0:

A On the [Start] menu, point to [Settings], and then click [Printers].
B Double-click the Add Printer icon.
C Follow the instructions in Add Printer Wizard.
Note
❒ If the printer driver is on a CD-ROM, the location of the PostScript 3 printer
driver is either D:\DRIVERS\PS3\WIN9X_ME\(Language)\DISK1,
D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1, or D:\DRIVERS\PS3\NT4\(Language)\DISK1. If the installer starts, click [Cancel] to quit.

For Windows XP Professional and Windows Server 2003:

A On the [Start] menu, click [Printers and Faxes].
B Click [Add a printer].
C Follow the instructions in Add Printer Wizard.
Note
❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver is D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1. If the installer
starts, click [Cancel] to quit.

For Windows XP Home Editions:

A On the [Start] menu, click [Control Panel].
B Click [Printers and Other Hardware].
C Click [Printers and Faxes].
D Click [Install Printer].
E Follow the instructions in Add Printer Wizard.
Note
❒ If the printer driver is on a CD-ROM, the location of the RPCS printer driver is D:\DRIVERS\PS3\WIN2K_XP\(Language)\DISK1. If the installer
starts, click [Cancel] to quit.
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Making Option Settings for the Printer
Make option settings for the machine using the printer driver when bidirectional
communication is disabled.

1

Reference
For details about making option settings for the printer, see p.63 “Setting Up
Options”.

Set up option settings when bidirectional communications are disabled.
Limitation
❒ Under Windows 2000/XP and Windows Server 2003, Manage Printers permission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.
❒ Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] folder. Log on as an Administrators or Power Users group member.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
D Click the [Accessories] tab.
Note
❒ Under Windows 2000 / XP, Windows Server 2003 and Windows NT 4.0,
click the [Device Settings] tab.

E Select options installed from the [Options] area, and then make the necessary settings.

F Select the total amount of the memory in [Total memory:], when the optional
SDRAM module is added.

G Under [Paper source tray settings], click and highlight the tray to be used, and

then select the appropriate size, position, and type for the tray. Select the
[Tray locking] check box to exclude the tray from the targets of automatic tray
selection.

H Click [OK] to close the printer properties dialog box. Click the [Defaults] tab,
and then click [Change Accessories] to display the option selection.
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Setting Up the Printer Driver
Windows 95 / 98 / Me - Accessing the Printer Properties

1

There are two methods to open the printer properties dialog box.

Making printer default settings
To make the printer default settings, open the printer properties dialog box from
the [Printers] window.
Important
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.
Note
❒ With some applications, the printer driver settings are not used, and the application's own default settings are applied.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
The printer properties dialog box appears.

D Make the necessary settings, and then click [OK].
E Click [OK].
Reference
For details, see the printer driver Help.
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Making printer settings from an application
You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

1

Note
❒ The procedure to open the printer properties dialog box may vary depending on
the application. For details, see the manuals provided with the application you use.

❒ With some applications, the printer driver settings are not used, and the application's own default settings are applied.
❒ Any settings you make in the following procedure are valid for the current
application only.
❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

C Make the necessary settings, and then click [OK].
D Click [OK] to start printing.
Reference
For details, see the printer driver Help.
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Windows 2000 - Accessing the Printer Properties
Making printer default settings - the printer properties

1

Important
❒ To change the printer default settings including option configuration settings, log
on using an account that has Manage Printers permission. Members of the Administrators and Power Users groups have Manage Printers permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
The printer properties dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].
Reference
For details, see the printer driver Help.

Making printer default settings - Printing Preferences
Important
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
Reference
For details, see the printer driver Help.
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Making printer settings from an application
You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

1

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary depending on the application. For details, see the manuals provided with the application you use.
❒ Any settings you make in the following procedure are valid for the current
application only.
❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A

On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.
C On the [Preferences] tab, make the necessary settings, and then click [Print]
to start printing.

Reference
For details, see the printer driver Help.
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Windows XP, Windows Server 2003 - Accessing the Printer Properties
Making printer default settings - the printer properties

1

Important
❒ To change the printer default settings including option configuration settings, log
on using an account that has Manage Printers permission. Members of the Administrators and Power Users groups have Manage Printers permission by default.
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
The printer properties dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
❒ Do not make a setting for [Form to Tray Assignment].
Reference
For details, see the printer driver Help.

Making printer default settings - Printing Preferences
Important
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.
Reference
For details, see the printer driver Help.
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Making printer settings from an application
You can make printer settings for a specific application.
To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

1

Note
❒ The procedure to open the [Printing Preferences] dialog box may vary depending on the application. For details, see the manuals provided with the application you use.
❒ Any settings you make in the following procedure are valid for the current
application only.
❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A

On the [File] menu, click [Print...].
The [Print] dialog box appears.

B Select the printer you want to use in the [Select Printer] list.
C On the [Preference] tab, make the necessary settings, and then click [Print] to
start printing.

Reference
For details, see the printer driver Help.
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Windows NT 4.0 - Accessing the Printer Properties
Making printer default settings - the printer properties

1

Important
❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Administrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears .

B Click the icon of the printer you want to use.
C On the [File] menu, click [Properties].
The printer properties dialog box appears.

D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.

❒ Do not make a setting for [Form to Tray Assignment].
Reference
For details, see the printer driver Help.

Making printer default settings - Default
Important
❒ To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Administrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.
❒ You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

A On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
C On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.
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D Make the necessary settings, and then click [OK].
Note
❒ Settings you make here are used as the default settings for all applications.

1

Reference
For details, see the printer driver Help.

Making printer settings from an application
You can make printer settings for a specific application.
To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.
Note
❒ The procedure to open the printer properties dialog box may vary depending
on the application. For details, see the manuals provided with the application
you use.

❒ With some applications, the printer driver settings are not used, and the application's own default settings are applied.
❒ Any settings you make in the following procedure are valid for the current
application only.
❒ General users can change the properties displayed in the [Print] dialog box of
an application. Settings made here are used as defaults when printing from
this application.

A On the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

C Make the necessary settings, and then click [OK].
D Click [OK] to start printing.
Reference
For details, see the printer driver Help.
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Mac OS
This section explains how to configure a Mac OS to use EtherTalk and USB.
The following explains how to configure Mac OS 9.1. If you are not using Mac
OS 9.1, see the manual of the Mac OS you are using for details
Important
❒ For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)
Note
❒ The PostScript 3 printer driver is stored in the following folder on the CDROM.

Mac OS 8 and 9:PS Driver:(language):Disk1

Installing the PostScript 3 Printer Driver and PPD File
It is necessary to install a printer driver and PostScript Printer Description (PPD)
files to print from a Mac OS.
Follow the procedure below to install a printer driver and a PPD file into a Mac
OS using Mac OS 8.6 and higher.

PostScript 3 Printer Driver

A Insert the CD-ROM into the CD-ROM drive.
B Double-click the CD-ROM drive icon.
C Double-click the [Mac OS 8 and 9] folder.
D Double-click the [PS Driver] folder.
E Double-click the folder of the language you use.
F Open [Disk1], and then double-click the installer icon.
G Follow the instructions on the screen.
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PPD Files

A Double-click the CD-ROM drive icon.
B Double-click the [Mac OS 8 and 9] folder.
C Double-click the [Printer Descriptions] folder.
D Double-click the folder of the language you are using.
E Open the [DISK1] folder.
F Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions]

2

under [System Folder].

G Restart the Mac OS.
Setting Up PPD Files
Important
❒ Make sure that the printers are connected to an AppleTalk network before
performing the following procedure.

A On the [Apple] menu, click [Chooser].
B Click the Adobe PS icon.
C In the [Select a PostScript Printer:] list, click the name of the printer you want
to use.

D Click [Create].
E Click the printer you want to use, and then click [Setup].
A PPD file is set up and the Adobe PS icon appears at the left of the printer
name in the list. Follow the procedure on p.55 “Setting Up Options” to make
option settings; otherwise close the [Chooser] dialog box.
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Setting Up Options

A On the [Apple] menu, click [Chooser].
B Click the Adobe PS icon.
C In the [Select a PostScript Printer:] list, click the name of the printer you want

2

to use, and then click [Setup].

D Click [Configure].
A list of options appears.

E Select the option you want to set up, and then select an appropriate setting
for it.

F Click [OK].
The list of options closes.

G Click [OK].
The [Chooser] dialog box appears.

H Close the [Chooser] dialog box.
Note
❒ If the option you want to select is not displayed, PPD files may not be set
up correctly. To complete the setup, check the name of the PPD file displayed in the dialog box.

Installing Adobe Type Manager
Important
❒ Quit all applications currently running before installation. Install ATM after
you restart the computer.

A Start a Mac OS.
B Insert the CD-ROM into the CD-ROM drive.
C Double-click the CD-ROM drive con.
D Double-click the [Mac OS 8 and 9] folder.
E Double-click the [ATM] folder.
F Double-click the ATM 4.6.2 installer icon.
G Follow the instructions on the screen.
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H When the procedure is complete, restart the computer. ATM will be completely installed only after restarting.

I On the [Apple] menu, open [Control Panel], and then click [~ATM].
J The ATM control panel opens.
Note
❒ For details about installation, see the operating instructions in the ATM
folder.

2

Installing Screen fonts
Follow the procedure below to install screen fonts.
The screen fonts described below can be found in the [Fonts] folder on the CDROM.

A Start a Mac OS.
B Insert the CD-ROM into the CD-ROM drive.
The CD-ROM drive icon appears.

C Double-click the CD-ROM drive icon.
The contents of the CD-ROM appear.

D Double-click the [Mac OS 8 and 9] folder.
E Double-click the [Fonts] folder.
F Double-click the [Screen font] folder.
G Double-click the [TrueType] or [Type1] folder.
Select the font type you want to use.

H Copy the fonts you want to install in [System Folder].
A confirmation message appears.

I Click [OK].
The fonts are installed.

J Restart the Mac OS.
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Changing to EtherTalk
Follow the procedure below to configure to a Mac OS to use EtherTalk.

A Open [Control Panel], and then double-click the AppleTalk icon.
B On the [Connect via:] pop-up menu, click [Ethernet].
C If you change zones, select a name on the [Current zone:] pop-up menu.
D Close the AppleTalk control panel.
E Restart the computer.

2

Note
❒ The procedures used to configure Mac OS may vary depending on the Mac
OS version. The following describes how to configure Mac OS 9.1. If you
are using a different version of Mac OS, use the following procedures as a
reference and see the manuals for your Mac OS version.

❒ Confirm the Connection to the Printer with TCP/IP
Reference
For information about installing applications required for EtherTalk, see
the Mac OS manuals.
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Mac OS X
This section explains how to configure a Mac OS X to use EtherTalk, USB and
TCP/IP.
Follow the procedure below to configure Mac OS X 10.3.6. If you are not using
Mac OS X 10.3.6, see the manual of the Mac OS X you are using for details.

2

Important
❒ For Mac OS X 10.1 or higher.
Note
❒ The PPD files are stored in the following folder on the CD-ROM.
Mac OS X:PPD Installer

Installing the PPD Files
Follow the procedure below to install a PPD file to print from Mac OS X.
Important
❒ You need an administrator name and a password (phrase). For details, consult your network administrator.

A Insert the CD-ROM into the CD-ROM drive.
B Double-click the CD-ROM drive icon.
C Double-click the [Mac OS X] folder.
D Double-click the [Mac OS X PPD Installer] folder.
E Double-click the installer icon.
F Follow the instructions on the screen.
Setting Up the PPD File

A Start Printer Setup Utility.
B Click [Add].
Click [AppleTalk] on the first pop-up menu.
If the zone is set, select the zone from the second pop-up menu.

C Select the PPD file for the model you are using from the [Printer Model:] popup menu, and then click [Add].
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Setting Up Options
Important
❒ No printer option settings can be made under Mac OS X. No new settings for
options not installed can be made.

2

Using USB Interface
Follow the procedure below to set up USB connection.

A Start Printer .
B Click [Add].
C Click [USB] on the pop-up menu.
The connected printer appears.

D Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.
A list of printer types appears.

E Select the connected printer from the list of printer models, and then click
[Add].

F Close the [Printer List] dialog box, and then quit Printer Setup Utility.
Note
❒ When printing with a USB connection to a Macintosh computer, printer
language does not change automatically. Use the control panel on this
printer to change printer language to [Auto Detect] or [PS] before printing.

❒ USB2.0 can be used only with Mac OS X 10.3.3 or higher.
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Using Rendezvous
Follow the procedure below to print using Rendezvous under Mac OS X 10.2.3
or higher. Ethernet, wireless LAN and IEEE 1394 (IP over 1394) connections can
also be used.

A Start Printer Setup Utility.
B Click [Add].
C Click [Rendezvous] on the pop-up menu.

2

The connected printer appears.

D Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.
A list of printer types appears.

E Select the name of the connected printer from the list of printer models, and
then click [Add].

F Close the [Printer List] dialog box, and then quit Printer Setup Utility.
Note
❒ When printing with a Rendezvous connection to a Macintosh computer,
printer language does not change automatically. Use the control panel on
this printer to change printer language to [Auto Detect] or [PS] before printing.

Changing to EtherTalk
Important
❒ You need an administrator name and a password (phrase). For details, consult your network administrator

Follow the procedure below to configure a Mac OS X to use EtherTalk.
Reference
For information about installing applications required for EtherTalk, see the
Mac OS manuals.

A Open [System Preference], and then click the Network icon.
B Click the [AppleTalk] tab.
C Select the [Make AppleTalk Active] check box.
D To change AppleTalk zones, select a name from the [AppleTalk Zone:] pop-up
menu.
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E When the settings are made, click [Apple Now].

Configuring the Printer

Configuring the Printer
Use the control panel to enable AppleTalk. (The default is active.)

2
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2
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Setting Up Options
To use installed options correctly, first set up the printer driver. If the options are
not recognized, you cannot use them, even though they are physically installed.
The procedure to set up a printer driver varies depending on the operating system.
Reference
See p.44 “Making Option Settings for the Printer”, p.55 “Setting Up Options”
or p.59 “Setting Up Options” for the installation method appropriate to your
printing environment.

❖ Windows
You can set up any of the options using the following tabs:
Windows 95 / 98 / Me

[Options] on the [Accessories] tab.

Windows 2000 / XP,
Windows Server 2003

[Installable Options] on the [Device Settings] tab.

Windows NT 4.0

[Installable Options] on the [Device Setting] tab in the
Properties dialog box.

Mac OS

For ethernet, [Chooser] on the Apple Menu. For USB,
[Change Setup] from the [Printing] menu to open the
Desktop printer.

Mac OS X

This function is not available.

Note
❒ To set up options, access the printer driver from Windows. You cannot set
up options if you access the printer driver from an application.
Limitation
❒ If your system is Windows 2000, Windows XP Professional, or Windows
Server 2003, changing printer driver settings requires Manage Printers
permission. Members of Administrators and Power Users groups have
Manage Printers permission by default. When you change printer driver
settings, log on with an account that has Manage Printers permission.
❒ If your system is Windows NT 4.0, changing printer driver settings requires Full Control access permission. Members of Administrators, Server
Operators, Print Operators, and Power Users groups have Full Control
permission by default. When you change printer driver settings, log on
with an account that has Full Control permission.
❒ If you are using Adobe Page Maker 6.0, 6.5, or 7.0 with Windows 95 / 98 /
Me / 2000 / XP, Windows Server 2003, or Windows NT 4.0, you have to
set up options in the Adobe PageMaker's print dialog box.

❖ Mac OS
You can set up all options using the [Chooser] dialog box.
Limitation
❒ If you are using Mac OS X, this functions cannot be used.
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Printing a Document
This documentation describes the specific printer functions and menus that are
added by installing the PPD file. For more information about the functions and
menus of the Windows 95 / 98 / Me PostScript printer driver, see the printer
driver's Help.
Preparation
On a Macintosh, Mac OS 8.6 or higher (Mac OS X Classic environment is supported.), or Mac OS X 10.1 or higher is required.

3

Limitation
❒ If you are using Mac OS X 10.1.x, the following functions cannot be used:
• Sample Print
• Locked Print
• Hold Print
• Stored Print
• Document Server
• User Code
Note
❒ If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.
❒ “Mac OS X” in the tables below refers to Mac OS X 10.2.3. Depending on the
version, [Features x] is displayed as [Set x] (x is a number). Make adjustments
according to the version you use.

Job Type
Use this to select the type of print job.
The following table shows the tabs or menus where you can select this function.
Windows 95 / 98 / Me

[Job Type:] on the [Setup] tab.

Windows 2000 / XP,
Windows Server 2003

[Job Type:] on the [Job Log] tab in the Printing Preferences
dialog box.

Windows NT 4.0

[Job Type:] on the [Job Log] tab in the Document Defaults
dialog box.

Mac OS

[Job Type:] on [Job Log] in the print dialog box.

Mac OS X

[Job Type:] on [Job Log] in the print dialog box.

You can select the following items:

❖ Normal
Select this for normal printing. The print job starts immediately after the print
command is given.
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Note
❒ Under Windows 95 / 98 / Me, if you want to use an User ID, click the [Details...] button.

Printing a Document

❖ Sample Print
Use this function to print only one set of a multiple print jobs.
The other sets are saved in the machine. The saved job can be printed from the
machine's control panel. You can also delete the saved job.
Limitation
❒ Applications with their own drivers, such as PageMaker, do not support
this function.
Note
❒ The “User ID” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

3

❒ Entering the “User ID” helps you distinguish your print job from others.
Reference
For details about how to use Sample Print, see p.66 “How to Use Sample
Print”.

❖ Locked Print
Use this function to save documents in the machine memory with a password, and then edit and print them as you want.
Limitation
❒ Applications with their own drivers, such as PageMaker, do not support
this function.
Note
❒ The “User ID” can contain to eight alphanumeric (a-z, A-Z, 0-9) characters.
The “Password” must be 4-8 digits.

❒ Entering the “User ID” helps you distinguish your print job from others.
Reference
For details about how to use Locked Print, see p.74 “How to Use Locked
Print”.

❖ Hold Print
Use this function to temporarily hold a file in the machine, and print it from
the computer or the machine's control panel later.
Limitation
❒ Applications with their own drivers, such as PageMaker, do not support
this function.
Note
❒ The “User ID” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters.

❒ Entering the “User ID” helps you distinguish your print job from others.
Reference
For details about how to use Hold Print, see p.81 “How to Use Hold Print”.
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❖ Stored Print
Use this function to store a file in the machine, and then print it from the computer or the machine's control panel later.
Limitation
❒ Applications with their own drivers, such as PageMaker, do not support
this function.
Note
❒ The “User ID” can contain up to eight alphanumeric (a- z, A- Z, 0- 9) characters.The “Password” must be 4-8 digits.

3

❒ You can assign a password to a saved document, but password assignment
is not mandatory.
❒ Entering the “User ID” helps you distinguish your print job from others.
Reference
For details about how to use Stored Print, see p.87 “How to Use Stored
Print”.

❖ Document Server
Use this function to store hard disk documents that you want to print as well
as documents you might want to later combine or process for printing. For
details about the Document Server function, see "Accessing the Document
Server", Printer Reference.
Limitation
❒ Applications with their own drivers, such as PageMaker, do not support
this function.

How to Use Sample Print
Follow the procedure below to print a document using the Sample Print function.

Windows 95 / 98 / Me
Note
❒ If the application has a collate option, make sure it is not selected before sending a print job. The printer driver automatically collates Sample Print jobs by
default. If the collate option is selected in the application's [Print] dialog box,
there may be more prints than required.

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.
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B Select the printer, and then click [Properties].
C Click the [Setup] tab.
D In the [Job Type:] list, click [Sample Print].

Printing a Document

E Click [Details...].
F In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters.

Note
❒ The user ID associates the user with his / her jobs.

G Click [OK].
H Click [OK] to close the printer properties dialog box.
I Set the number of copies to two or more, and then start the printing from

3

the application's [Print] dialog box.
The sample print job is sent to the machine and one set is printed.

J Check the printed output to make sure the settings are correct.
If the settings are correct, perform the following steps.
If you want to delete a saved job, see p.73 “Deleting a Sample Print File”.

K On the machine's control panel, press the {Printer} key to display the printer
screen.

L Press [Print Jobs].

M Press [Sample Print Job List].
A list of sample print files stored in the machine appears.

The following items also appear:
• User ID: The user ID set up by the printer driver.
• Date / Time: The date and time when jobs were sent from the computer.
• File Name: The names of files stored in the machine.
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N Select the file you want to print by pressing it.
A list of the print files stored in the machine appears.
Note
❒ To select all print jobs, press [Select All Jobs].

❒ Press [U Prev.] or [T Next.] to scroll through the list.
❒ To cancel a selection, press the highlighted print job again. To clear all selections, press [Clear Alll].
❒ To view details about a selected print file, press [Details].

O Press [Print] to change the number of sets to be printed.
P Enter the new number of sets using the number keys.

3

If you do not want to change the set quantity, perform the following step.
Note
❒ You can enter up to 999 sets.

❒ Press {Clear/Stop} to correct any entry mistakes.
❒ When multiple files are selected without setting a quantity, 1 page less
than the minimum number of all settings is applied.

Q Press [Yes].
The remaining sets are printed.
Note
❒ Press [No] to cancel printing.

❒ When printing finishes, the stored file is deleted.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.
❒ If there is a print job outstanding, this is printed before the sample print job.
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Windows 2000 / XP, Windows Server 2003, Windows NT 4.0
Note
❒ If the application has a collate option, make sure it is not selected before sending a print job. The printer driver automatically collates Sample Print jobs by
default. If the collate option is selected in the application's [Print] dialog box,
there may be more prints than required.

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

3

B Select the printer, and then click [Properties].
Note
❒ If you are using Windows 2000, select the printer, and then perform the following steps.

❒ If you are using Windows XP or Windows Server 2003, select the printer,
and then click [Preferences].

C Click the [Job Log] tab.
D In the [Job Type:] list, click [Sample Print].
E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters.

Note
❒ The user ID associates the user with his / her jobs.

F Click [OK] to close the printer properties dialog box.
Note
❒ If you are using Windows 2000, perform the following steps.

G Set the number of copies to two or more, and then start the printing from
the application's [Print] dialog box.
The sample print job is sent to the machine, and one set is printed.

H Check the printed output to make sure the settings are correct.
If the settings are correct, perform the following steps to print the remaining sets.
If you want to delete a saved job, see p.73 “Deleting a Sample Print File”.

I On the machine's control panel, press the {Printer} key to display the printer
screen.
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J Press [Print Jobs].

K Press [Sample Print Job List].
A list of sample print files stored in the machine appears.

3

The following items also appear:
• User ID: The user ID set up by the printer driver.
• Date / Time: The date and time when jobs were sent from the computer.
• File Name: The names of files stored in the machine.

L Select the file you want to print by pressing it.
A list of print files stored in the machine appears.
Note
❒ To select all print jobs, press [Select All Jobs].

❒ Press [U Prev.] or [T Next.] to scroll through the list.
❒ To cancel a selection, press the highlighted print job again. To clear all selections, press [Clear All].
❒ To view details about a selected print file, press [Details].

M Press [Print] to change the number of sets to be printed.
N Enter the new number of sets using the number keys.

If you do not want to change the set quantity, perform the following steps.
Note
❒ You can enter up to 999 sets.
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❒ Press {Clear/Stop} to correct any entry mistakes.
❒ When multiple files are selected without setting a quantity, 1 page less
than the minimum number of all settings is applied.

Printing a Document

O Press [Yes].
The remaining sets are printed.
Note
❒ Press [No] to cancel printing.

❒ When printing finishes, the stored file is deleted.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.
❒ If there is a print job outstanding, this will be printed before the sample
print job.

3

Mac OS / Mac OS X
Limitation
❒ If you are using Mac OS X 10.1.x, this function cannot be used.
Note
❒ If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Set the number of copies to two or more.
The sample print job is sent to the machine, and one set is printed.

C In the pop-up menu, click [Job Log].
D On the [Job Type:] pop-up menu, select [Sample Print].
E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters.

Note
❒ The user ID associates the user with his / her jobs.

F Check the printed output to make sure the settings are correct.
If the settings are correct, perform the following steps to print the remaining sets.
If you want to delete a saved job, see p.73 “Deleting a Sample Print File”.

G On the machine's control panel, press the {Printer} key to display the printer
screen.
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H Press [Print Jobs].

I Press [Sample Print Job List].
A list of sample print files stored in the machine appears.

3

The following items also appear:
• User ID: The user ID set up by the printer driver.
• Date / Time: The date and time when jobs were sent from the computer.
• File Name: The names of files stored in the machine.

J Select the file you want to print by pressing it.
A list of print files stored in the machine appears.
Note
❒ To select all print jobs, press [Select All Jobs].

❒ Press [U Prev.] or [TNext.] to scroll through the list.
❒ To cancel a selection, press the highlighted print job again. To clear all selections, press [Clear All].
❒ To view details about a selected print file, press [Details].

K Press [Print] to change the number of sets to be printed.
L Enter the new number of sets using the number keys.

If you do not want to change the set quantity, perform the following steps.
Note
❒ You can enter up to 999 sets.
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❒ Press {Clear/Stop} to correct any entry mistakes.
❒ When multiple files are selected without setting a quantity, 1 page less
than the minimum number of all settings is applied.
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M Press [Yes].
The remaining sets are printed.
Note
❒ Press [No] to cancel printing.

❒ When printing fiishes, the stored file is deleted.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.
❒ If there is a print job outstanding, this is printed before the sample print job.

3

Deleting a Sample Print File
If a printed document is not as required, you can delete the Sample Print file.

A On the machine's control panel, press the {Printer} key to display the printer
screen.

B Press [Print Jobs].
A list of print files stored in the machine appears.

C Press [Stored Print Job List].
A list of sample print files stored in the machine appears.

D Select the file you want to delete by pressing it.
Note
❒ Press [U Prev.] or [T Next.] to scroll through the list.

❒ To cancel a selection, press the highlighted jobs again.
❒ Only one file can be selected at a time.

E Press [Delete].
A confirmation screen appears.

F Press [Yes] to delete the file.
After the file is deleted the printer screen reappears.
Note
❒ Press [No] to cancel the delete request.

73

Using PostScript 3

How to Use Locked Print
Follow the procedure below to print a document using the Locked Print function.

Windows 95 / 98 / Me
Note
❒ If the application has a collate option, make sure it is not selected before sending a print job. The printer driver automatically collates Locked Print jobs by
default. If the collate option is selected in the application's [Print] dialog box,
there may be more prints than required.

3

A In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

B Select the printer, and then click [Properties].
C Click the [Setup] tab.
D In the [Job Type:] list, click [Locked Print].
E Click [Details...].
F In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters, and then enter a 4-8 digit password in the [Password:] box.

Note
❒ The user ID associates the user with his / her jobs.

G Click [OK].
H Click [OK] to close the printer properties dialog box.
I After making the necessary settings, click [OK] to close the [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.80 “Deleting a Locked Print File”.

J On the machine's control panel, press the {Printer} key to display the printer
screen.

K Press [Print Jobs].

A list of print files stored in the machine appears.
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L Press [Locked Print Job List].
A list of locked print files stored in the machine appears.

The following items also appear:
• User ID: The user ID set up by the printer driver.
• Date / Time: The date and time when jobs were sent from the computer.
• File Name: The names of files stored in the machine.

3

M Select the file you want to print by pressing it.
Note
❒ To select all print jobs, press [Select All Jobs].

❒ Press [U Prev.] or [T Next.] to scroll through the list.
❒ To cancel a selection, press the highlighted print job again. To clear all selections, press [Clear All].
❒ To view details about a selected print file, press [Details].

N Press [Print].
The password screen appears.

O Enter the password using the number keys, and then press [OK].
A confirmation screen appears.
Note
❒ A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.
❒ When multiple print files are selected, the machine prints only files that
correspond to the entered password. The number of files is displayed on
the confirmation screen.

P Press [Yes].
A locked file is printed.
Note
❒ Press [No] to cancel printing.

❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.
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Windows 2000 / XP, Windows Server 2003, Windows NT 4.0
Note
❒ If the application has a collate option, make sure it is not selected before sending a print job. The printer driver automatically collates Locked Print jobs by
default. If the collate option is selected in the application's [Print] dialog box,
there may be more prints than required.

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

3

B Select the printer, and then click [Properties].
Note
❒ If you are using Windows 2000, select the printer, and then perform the following steps.

❒ If you are using Windows XP or Windows Server 2003, select the printer,
and then click [Preferences].

C Click the [Job Log] tab.
D In the [Job Type:] list, click [Locked Print].
E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters, and then enter a 4-8 digit password in the [Password:] box. File
Name can also be set.

Note
❒ The user ID associates user with his / her jobs.

F Click [OK] to close the printer properties dialog box.
Note
❒ If you are using Windows 2000, perform the following steps.

G Start the printing from the application's [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.80 “Deleting a Locked Print File”.

H On the machine's control panel, press the {Printer} key to display the printer
screen.
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I Press [Print Jobs].

A list of print files stored in the machine appears.

J Press [Locked Print Job List].
A list of locked print files stored in the machine appears.

3

The following items also appear:
• User ID: The user ID set up by the printer driver.
• Date / Time: The date and time when jobs were sent from the computer.
• File Name: The names of files stored in the machine.

K Select the file you want to print by pressing it.
Note
❒ To select all print jobs, press [Select All Jobs].

❒ Press [U Prev.] or [T Next.] to scroll through the list.
❒ To cancel a selection, press the highlighted print job again. To clear all selections, press [Clear All].
❒ To view details about a selected print file, press [Details].

L Press [Print].
The password screen appears.
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M Enter the password using the number keys, and then press [OK].
A confirmation screen appears.
Note
❒ A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

❒ When multiple print files are selected, the machine prints only files that
correspond to the entered password. The number of files is displayed on
the confirmation screen.

N Press [Yes].

3

The locked file is printed.
Note
❒ Press [No] to cancel printing.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.

Mac OS / Mac OS X
Limitation
❒ If you are using Mac OS X 10.1.x, this function cannot be used.
Note
❒ If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

A In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

B In the pop-up menu, click [Job Log].
C On the [Job Type:] pop-up menu, click [Locked Print].
D In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters, and then enter a 4-8 digit password in the [Password:] box.

Note
❒ The user ID associates the user with his / her jobs.

E After making the necessary settings, click [Print].
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.80 “Deleting a Locked Print File”.

F On the machine's control panel, press the {Printer} key to display the printer
screen.
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G Press [Print Jobs].

A list of print files stored in the machine appears.

H Press [Locked Print Job List].
A list of locked print files stored in the machine appears.

3

The following items also appear:
• User ID: The user ID set up by the printer driver.
• Date / Time: The date and time when jobs were sent from the computer.
• File Name: The names of files stored in the machine.

I Select the file you want to print by pressing it.
Note
❒ To select all print jobs, press [Select All Jobs].

❒ Press [U Prev.] or [T Next.] to scroll through the list.
❒ To cancel a selection, press the highlighted print job again. To clear all selections, press [Clear All].
❒ To view details about a selected print file, press [Details].

J Press [Print].
The password screen appears.
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K Enter the password using the number keys, and then press [OK].
A confirmation screen appears.
Note
❒ A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

❒ When multiple print files are selected, the machine prints only files that
correspond to the entered password. The number of files is displayed on
the confirmation screen.

L Press [Yes].

3

The locked file is printed.
Note
❒ Press [No] to cancel printing.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.

Deleting a Locked Print File
If a printed document is not as required, you can delete the Locked Print file.

A On the machine's control panel, press the {Printer} key to display the printer
screen.

B Press [Print Jobs].
A list of print files stored in the machine appears.

C Press [Locked Print Job List].
A list of locked print files stored in the machine appears.

D Select the file you want to delete by pressing it.
Note
❒ Press [U Prev.] or [T Next.] to scroll through the list.

❒ To cancel a selection, press the highlighted job again.
❒ Only one file can be selected at a time.

E Press [Delete].
A password screen appears.
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F Enter the password using the number keys, and then press [OK].
A confirmation screen appears.
Note
❒ A confirmation screen will reappear if the password was entered incorrectly. Press [OK] to enter the password again.

❒ When multiple files are selected, the machine deletes only files that correspond to the entered password. The number of files to be deleted is displayed on the confirmation screen.

G Press [Yes].

3

After the file is deleted, the printer screen reappears.
Note
❒ Press [No] to cancel the delete request.

How to Use Hold Print
Follow the procedure below to print a document using the Hold Print function.

Windows 95 / 98 / Me
Note
❒ If the application has a collate option, make sure it is not selected before sending a print job. The printer driver automatically collates Hold Print jobs by default.If a collate option is selected from the application's Print dialog box,
there may be more prints than required.

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer, and then click [Properties].
C Click the [Setup] tab.
D In the [Job Type:] list, click [Hold Print].
E Click [Details...].
F In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters. File Name can also be set.

Note
❒ The user ID associates the user with his / her jobs.

G Click [OK].
H Click [OK] to close the printer properties dialog box.
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I After making the necessary settings, click [OK] to close the [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.87 “Deleting a Hold Print File”.

J On the machine's control panel, press the {Printer} key to display the printer
screen.

K Press [Print Jobs].

3

A list of the print files stored in the machine appears.

L Press [Hold Print Job List].
A list of hold print files stored in the machine appears.

The following items also appear:
• User ID: The user ID set up by the printer driver.
• Date / Time: The date and time when jobs were sent from the computer.
• File Name: The names of files stored in the machine.
Note
❒ Depending on the security settings, certain print jobs may not be displayed.

M Select the file you want to print by pressing it.
Note
❒ To select all print jobs, press [Select All Jobs].

❒ Press [U Prev.] or [T Next.] to scroll through the list.
❒ To cancel a selection, press the highlighted job again. To clear all selections,
press [Clear All].
❒ To view details about a selected print file, press [Details].

N Press [Print].
A confirmation screen appears.
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O Press [Yes].
The hold print file is printed.
Note
❒ Press [No] to cancel printing.

❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.
❒ When printing is finished, the stored file is deleted.

Windows 2000 / XP, Windows Server 2003, Windows NT 4.0

3

Note
❒ If the application has a collate option, make sure it is not selected before sending a print job. The printer driver automatically collates Hold Print files by
default. If a collate option is selected from the application's Print dialog box,
there may be more prints than required.

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Right-click the printer icon, and then click [Printing Preference] on the command menu.

Note
❒ If you are using Windows 2000, select the printer, and then perform the following steps.

❒ If you are using Windows XP or Windows Server 2003, select the printer,
and then click [Preferences].

C Click the [Job Log] tab.
D In the [Job Type:] list, click [Hold Print].
E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters. File Name can also be set.

Note
❒ The user ID associates the user with his / her jobs.

F Click [OK] to close the printer properties dialog box.
Note
❒ If you are using Windows 2000, perform the following steps.

G Start the printing from the application's [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.87 “Deleting a Hold Print File”.
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H On the machine's control panel, press the {Printer} key to display the printer
screen.

I Press [Print Jobs].

A list of print files stored in the machine appears.

3

J Press [Hold Print Job List].
A list of hold print files stored in the machine appears.

The following items also appear:
• User ID: The user ID set up by the printer driver.
• Date / Time: The date and time when jobs were sent from the computer.
• File Name: The names of files stored in the machine.
Note
❒ Depending on the security settings, certain print jobs may not be displayed.

K Select the file you want to print by pressing it.
Note
❒ To select all print jobs, press [Select All Jobs].

❒ Press [U Prev.] or [T Next.] to scroll through the list.
❒ To cancel a selection, press the highlighted job again. To clear all selections,
press [Clear All].
❒ To view details about a selected print file, press [Details].

L Press [Print].
A confirmation screen appears.

M Press [Yes].
The hold print file is printed.
Note
❒ Press [No] to cancel printing.
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❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.
❒ When printing finishes, the stored file is deleted.
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Mac OS / Mac OS X
Limitation
❒ If you are using Mac OS X 10.1.x, this function cannot be used.
Note
❒ If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

A From an application, on the [File] menu, click [Print].
The [Print] dialog box appears.

3

B In the pop-up menu, click [Job Log].
C On the [Job Type:] pop-up menu, click [Hold Print].
D In the [User ID:] box, enter the user ID using up to eight alphanumeric (a-z,
A-Z, 0-9) characters. File Name can also be set. File Name can also be set.

Note
❒ The user ID associates the user with his / her jobs.

E After making the necessary settings, click [Print].
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.87 “Deleting a Hold Print File”.

F On the machine's control panel, press the {Printer} key to display the printer
screen.

G Press [Print Jobs].

A list of print files stored in the machine appears.
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H Press [Hold Print Job List].
A list of hold print files stored in the machine appears.

The following items also appear:
• User ID: The user ID set up by the printer driver.
• Date / Time: The date and time when jobs were sent from the computer.
• File Name: The names of files stored in the machine.

3

Note
❒ Depending on the security settings, certain print jobs may not be displayed.

I Select the file you want to print by pressing it.
Note
❒ To select all print jobs, press [Select All Jobs].

❒ Press [U Prev.] or [T Next.] to scroll through the list.
❒ To cancel a selection, press the highlighted job again. To clear all selections,
press [Clear All].
❒ To view details about a selected print file, press [Details].

J Press [Print].
A confirmation screen appears.

K Press [Yes].
The hold print file is printed.
Note
❒ Press [No] to cancel printing.
❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.
❒ When printing is completed, the stored file is deleted.
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Deleting a Hold Print File
If a printed document is not as required, you can delete the Hold Print file.

A On the machine's control panel, press the {Printer} key to display the printer
screen.

B Press [Print Jobs].
A list of the print files stored in the machine appears.

C Press [Hold Print Job List].

3

A list of Hold Print files stored in the machine appears.
Note
❒ Depending on the security settings, certain print jobs may not be displayed.

D Select the file you want to delete by pressing it.
A confirmation screen appears.

E Press [Yes].
After the file is deleted, the printer screen reappears.
Note
❒ Press [No] to cancel the delete request.

How to Use Stored Print
Follow the procedure below to print a document using the Stored Print function.

Windows 95 / 98 / Me
Note
❒ If the application has a collate option, make sure it is not selected before sending a print job.The printer driver collates the Stored Print files by default. If a
collate option is selected from the application's Print dialog box, there may be
more prints than required.

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Select the printer, and then click [Properties].
C Click the [Setup] tab.
D In the [Job Type:] list, click [Stored Print].
E Click [Details...].
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F In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters, and then enter a 4-8 digit password in the [Password:] box. File
Name can also be set.

Note
❒ The user ID associates the user with his / her jobs.
❒ You can assign a password to a saved document, but password assignment
is not mandatory.
❒ The same password must be entered when printing or deleting.

G Click [OK].
H Click [OK] to close the printer properties dialog box.
I After making the necessary settings, click [OK] to close the [Print] dialog box.

3

The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.94 “Deleting a Stored Print File”.

J On the machine's control panel, press the {Printer} key to display the printer
screen.

K Press [Print Jobs].

A list of print files stored in the machine appears.

L Press [Stored Print Job List].
A list of stored print files stored in the machine appears.

The following items also appear:
• User ID: The user ID set up by the printer driver.
• Date / Time: The date and time when jobs were sent from the computer.
• File Name: The names of files stored in the machine.
Note
❒ Depending on the security settings, certain print jobs may not be displayed.
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M Select the file you want to print by pressing it.
Note
❒ To select all print jobs, press [Select All Jobs].

❒ Press [U Prev.] or [T Next.] to scroll through the list.
❒ To cancel a selection, press the highlighted job again. To clear all selections,
press [Clear All].
❒ To view details about a selected print file, press [Details].

N Press [Print].

3

A confirmation screen appears.
Note
❒ If you have already set a password, proceed to the following step.

O Enter a password using the number keys on the password screen, and then
press [OK]

Note
❒ A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.
❒ If you have not set the password, proceed to the following step.

P Press [Yes].
The stored print file is printed.
Note
❒ Press [No] to cancel printing.

❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.
❒ The Stored Print files sent to the machine are not deleted unless you delete
them in the machine or select [Auto Delete Stored Print Jobs] (see "System",
Printer Reference). For details, see p.94 “Deleting a Stored Print File”.
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Windows 2000 / XP, Windows Server 2003, Windows NT 4.0
Note
❒ If the application has a collate option, make sure it is not selected before sending a print job. The printer driver automatically collate Stored Print files by
default. If a collate option is selected from the application's Print dialog box,
there may be more prints than required.

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

3

B Right-click the printer icon, and then click [Printing Preference] on the command menu.

Note
❒ If you are using Windows 2000, select the printer, and then perform the following steps.
❒ If you are using Windows XP or Windows Server 2003, select the printer,
and then click [Preferences].

C Click the [Job Log] tab.
D In the [Job Type:] list, click [Stored Print].
E In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters, and then enter a 4-8 digit password in the [Password:] box. File
Name can also be set.

Note
❒ The user ID associates the user with his / her job.

❒ You can assign a password to a saved document, but password assignment
is not mandatory.
❒ The same password must be entered when printing or deleting.

F Click [OK] to close the printer properties dialog box.
Note
❒ If you are using Windows 2000, perform the following steps.

G Start the printing from the application's [Print] dialog box.
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.94 “Deleting a Stored Print File”.

H On the machine's control panel, press the {Printer} key to display the printer
screen.
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I Press [Print Jobs].

A list of print files stored in the machine appears.

J Press [Stored Print Job List].
A list of stored print files stored in the machine appears.

3

The following items also appear:
• User ID: The user ID set up by the printer driver.
• Date / Time: The date and time when jobs were sent from the computer.
• File Name: The names of files stored in the machine.
Note
❒ Depending on the security settings, certain print jobs may not be displayed.

K Select the file you want to print by pressing it.
Note
❒ To select all print jobs, press [Select All Jobs].
❒ Press [U Prev.] or [T Next.] to scroll through the list.
❒ To cancel a selection, press the highlighted job again. To clear all selections,
press [Clear All].
❒ To view details about a selected print file, press [Details].

L Press [Print].
A confirmation screen appears.
Note
❒ If you have already set a password, proceed to the following step.
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M Enter a password using the number keys on the password screen, and then
press [OK]

Note
❒ A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

3

❒ If you have not set the password, proceed to the following step.

N Press [Yes].
The stored file is printed.
Note
❒ Press [No] to cancel printing.

❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.
❒ Stored Print files sent to the machine are not deleted unless you delete
them in the machine or select [Auto Delete Stored Print Jobs] (see "System",
Printer Reference). For details, see p.94 “Deleting a Stored Print File”.

Mac OS / Mac OS X
Limitation
❒ If you are using Mac OS X 10.1.x, this function cannot be used.
Note
❒ If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B In the pop-up menu, click [Job Log].
C On the [Job Type:] pop-up menu, click [Stored Print].
D In the [User ID:] box, enter a user ID using up to eight alphanumeric (a-z, A-Z,
0-9) characters, and then enter a 4-8 digit password in the [Password:] box. File
Name can also be set.
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Note
❒ The user ID associates the user with his / her jobs.
❒ You can assign a password to a saved document, but password assignment
is not mandatory.
❒ The password must be entered when printing or deleting.

Printing a Document

E After making the necessary settings, click [Print].
The document file is saved in the machine.
To print the document, perform the following steps.
To delete the document, see p.94 “Deleting a Stored Print File”.

F On the machine's control panel, press the {Printer} key to display the printer
screen.

G Press [Print Jobs].

3
A list of print files stored in the machine appears.

H Press [Stored Print Job List].
A list of stored print files stored in the machine appears.

The following items also appear:
• User ID: The user ID set up by the printer driver.
• Date / Time: The date and time when jobs were sent from the computer.
• File Name: The names of files stored in the machine.
Note
❒ Depending on the security settings, certain print jobs may not be displayed.

I Select the file you want to print by pressing it.
❒
❒
❒
❒
❒

Note
To select all print jobs, press [Select All Jobs].
Press [U Prev.] or [T Next.] to scroll through the list.
If you have already set a password, enter it to print.
To cancel a selection, press the highlighted job again. To clear all selections,
press [Clear All].
To view details about a selected print file, press [Details].

J Press [Print].
A confirmation screen appears.
Note
❒ If you have already set a password, proceed to the following step.
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K Enter a password using the number keys on the password screen, and then
press [OK]

Note
❒ A confirmation screen will appear if the password is not entered correctly.
Press [OK] to enter the password again.

3

❒ If you have not set the password, proceed to the following step.

L Press [Yes].
The stored file is printed.
Note
❒ Press [No] to cancel printing.

❒ To cancel printing, press [Exit]. Then, press [Job Reset]. After it has started,
the file is deleted.
❒ Stored Print files sent to the machine is not deleted unless you delete them
in the machine or select [Auto Delete Stored Print Jobs] (see "System", Printer
Reference). For details, see p.94 “Deleting a Stored Print File”.

Deleting a Stored Print File
If a printed document is not as required, you can delete the stored print file.

A On the machine's control panel, press the {Printer} key to display the printer
screen.

B Press [Print Jobs].
A list of print files stored in the machine appears.

C Press [Stored Print Job List].
A list of stored print files stored in the machine appears.

D Select the file you want to delete by pressing it.
Note
❒ Press [U Prev.] or [T Next.] to scroll through the list.

❒ To cancel a selection, press the highlighted job again.

E Press [Delete].
A confirmation screen appears.

94

Printing a Document

F Press [Yes].
After the file is deleted, the printer screen reappears.
Note
❒ Press [No] to cancel the delete request.

❒ If you have already set a password in the printer driver, enter it to delete.

How to Use Document Server
Follow the procedure below to print a document using the Document Server function.

3

Note
❒ An optional hard disk drive is required to use the Document Server function.

Windows 95 / 98 / Me

A In the application, click [Print] on the [File] menu.
The [Print] dialog box appears.

B Select the printer, and then click [Properties].
C Click the [Setup] tab.
D In the [Job Type:] list, click [Document Server].
E Click [Details...].
F Enter a user ID, file name, and password in the dialog box that appears. The
file name and password are optional.

G Click [OK].
H Start the printing from the application's [Print] dialog box.
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Windows 2000 / XP, Windows Server 2003, Windows NT 4.0

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B Right-click the printer icon, and then click [Printing Preference] on the command menu.

Note
❒ If you are using Windows 2000, select the printer, and then perform the following steps.
❒ If you are using Windows XP or Windows Server 2003, select the printer,
and then click [Preferences].

3

C Click the [Job Log] tab.
D In the [Job Type:] list, click [Document Server].
E Enter a user ID, file name, and password in the dialog box that appears. The
file name and password are optional.

F Click [OK].
Note
❒ If you are using Windows 2000, perform the following steps.

G Start the printing from the application's [Print] dialog box.
Mac OS / Mac OS X
Limitation
❒ If you are using Mac OS X 10.1.x, this function cannot be used.
Note
❒ If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.

A In the application, on the [File] menu, click [Print].
The [Print] dialog box appears.

B In the pop-up menu, click [Job Log].
C On the [Job Type:] pop-up menu, click [Document Server].
D Enter a user ID, file name, and password in the dialog box that appears. The
file name and password are optional.

E Start the printing from the application's [Print] dialog box.
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User Code
Use this to set a user code for print logging.
Enter a user code using up to eight digits. A user code identifies a group of users
and allows you to check the number of sheets printed under each code with
SmartDeviceMonitor for Admin.
The following table shows the tabs or menus where you can select this function.
Windows 95 / 98 / Me

[User Code] on the [Statistics] tab.

Windows 2000 / XP,
Windows Server 2003

[User ID:] on the [Job Log] tab in the Printing Preferences
dialog box.

Windows NT 4.0

[User ID:] on the [Job Log] tab in the Document Defaults
dialog box.

Mac OS

[User ID:] on [Job Log] in the print dialog box.

Mac OS X

[User Code:] on [Job Log] in the print dialog box.

3

Reference
For details about using SmartDeviceMonitor for Admin, see Help.

Paper Selection
All Pages and Destination Tabs
Use this to select the media type and input tray.
Limitation
❒ This function is for Windows 95 / 98 / Me only.
Reference
For details about the [All Pages] and [Destination] tabs. See the printer driver's Help.
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Paper Size
Use this to select the size of paper you want to use.
The following table shows the tabs or menus where you can select this function.

3

Windows 95 / 98 / Me

[Size:] on the [Paper] tab.

Windows 2000 / XP,
Windows Server 2003

[Paper Size:] on [Paper/Output] on [Advanced...] on the [Paper/Quality] tab in the Printing Preference dialog box.

Windows NT 4.0

[Paper Size:] on the [Page Setup] tab in the Document Defaults dialog box.

Mac OS

[Paper:] on the [Page Attributes] tab in the Page Setup dialog box.

Mac OS X

[Paper Size:] in the Page Setup dialog box.

Reference
For details about the paper sizes supported by this machine, see General Setting Guide.

Fit to Paper
When the size of the document and paper size differ, set whether or not to print
according to paper size.
Windows 95 / 98 / Me

[Fit to Print Size:] on the [Paper] tab.

Windows 2000 / XP,
Windows Server 2003

[Fit to Paper:] on [Printer Features] on [Document Options] on
[Advanced...] on the [Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0

[Fit to Paper] on [Document Options] on the [Advanced] tab
in the Document Defaults dialog box.

Mac OS

[Fit to Paper:] on [Printer Specific Options] in the print dialog
box.

Mac OS X

[Fit to Paper:] on the [Features x] tab on [Printer Features] in
the print dialog box.

❖ Prompt User
Print is performed with the size of document to be printed unchanged.
❖ Nearest Size and Scale
If the paper size is smaller than the selected paper size, the driver reduces the
print size.
If the paper size is larger than the size of document to be printed, print is not
to fit the paper size.
❖ Nearest Size and Crop
When the paper size is smaller than the size of document to be printed, print
is adjusted to meet the paper size.
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Input Slot
Use this to select the paper sources.
The following table shows the tabs or menus where you can select this function.
Windows 95 / 98 / Me

[Input Tray:] on the [Paper] tab.

Windows 2000 / XP,
Windows Server 2003

[Paper Source] on the [Paper/Quality] tab in the Printing
Preferences dialog box.

Windows NT 4.0

The [Page Setup] tab in the Document Defaults dialog
box.

Mac OS

[Paper Source:] on [General] in the print dialog box.

Mac OS X

[Paper Feed] in the print dialog box.

3

Reference
For details about the paper sources, see Printer Reference.

Resolution
Use this to set the resolution types.
The following table shows the tabs or menus where you can select this function.
Windows 95 / 98 / Me

[Resolution] on the [Print Quality] tab.

Windows 2000 / XP,
Windows Server 2003

[Resolution] on [Graphic] on the [Paper/Quality] or [Layout]
tab in the Printing Preferences dialog box.

Windows NT 4.0

[Graphic] on the [Advanced] tab in the Document Defaults
dialog box.

Mac OS

[Resolution] on [Printer Specific Options] in the print dialog
box.

Mac OS X

[Resolution] on the [Features x] tab on [Printer Features] in
the print dialog box.

Reference
For more information about the resolution types, see Printer Reference.
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Print Mode (Toner Saving )
Use this function to reduce the amount of toner used when printing.
The following table shows the tabs or menus where you can select this function.

3

Windows 95 / 98 / Me

[Toner Saving] on the [Print Quality] tab.

Windows 2000 / XP,
Windows Server 2003

[Print Mode:] on [Printer Features] on [Advanced...] on the
[Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0

[Print Mode:] on [Printer Features] on [Document Options] on
the [Advanced] tab in the Document Defaults dialog box.

Mac OS

[Print Mode:] on [Printer Specific Options] in the print dialog
box.

Mac OS X

[Print Mode:] on the [Features x] tab on [Printer Features] in
the print dialog box.

Reference
For details about this function, see Printer Reference.

Duplex Printing
Use this function to select duplex printing.
Limitation
❒ To use this function, the optional duplex unit must be installed on the machine.

The following table shows the tabs or menus where you can select this function.
Windows 95 / 98 / Me

[Duplex:] on the [Setup] tab.

Windows 2000 / XP,
Windows Server 2003

[Print on Both Sides (Duplex)] on the [Layout] tab in the
Printing Preferences dialog box.

Windows NT 4.0

[Print on Both Sides (Duplex Printing)] on the [Page Setup] tab
in the Document Defaults dialog box.

Mac OS

[Print on Both Sides] on [Layout] in the print dialog box.

Mac OS X

The [Print on both Sides] check box on [Duplex:] in the print
dialog box.

You can select the following items: The following items may vary depending on
the operating system you are using.
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Windows 95 / 98 / Me
❖ Off
Disables Duplex Printing.
❖ Open to Left
Prints output so that you can open it to the left.
❖ Open to Top
Prints output so that you can open it to the top.

3

Windows 2000 / XP, Windows Server 2003, Mac OS, Mac OS X
Note
❒ If you are using a Mac OS, click to select the button that means “Flip on Long
Edge” or “Flip on Short Edge”.

❖ None
Disables Duplex Printing.
❖ Flip on Short Edge
Prints output so that you can open it to the short edge when bound along the
short edge.
❖ Flip on Long Edge
Prints output so that you can open it to the long edge when bound along the
long edge.
Windows NT 4.0
❖ None
Disables Duplex Printing.
❖ Short Side
Prints output so that you can open it to the short edge when bound along the
short edge.
❖ Long Side
Prints output so that you can open it to the long edge when bound along the
long edge.
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Gradation
Use this to select a type of gradation based on your purpose.
The following table shows the tabs or menus where you can select this function.

3

Windows 95 / 98 / Me

[Print Quality] tab.

Windows 2000 / XP,
Windows Server 2003

[Printer Features] on [Advanced...] on the [Paper/Quality] tab
in the Printing Preferences dialog box.

Windows NT 4.0

[Document Options] on the [Advanced] tab in the Document
Defaults dialog box.

Mac OS

[Printer Specific Options] in the print dialog box.

Mac OS X

[Gradation] on the [Features x] tab on [Printer Features] in
the print dialog box.

Reference
For details about the gradation types, see Printer Reference.
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Collate
Use this function to enable collation. With this feature, the machine can efficiently print collated sets of multiple-page documents.
Limitation
❒ To use this function, a memory unit of at least 192 MB or hard disk drive must
be installed on the machine.

❒ If you are using Windows 2000, Windows XP, Mac OS or Mac OS X, make
sure that the following check boxes have not been selected.
• Windows 2000
The [Collate] check box on [Printer Features] on [Advanced...] on the [Paper/
Quality] tab in the Printing Preferences dialog box.
• Windows XP
The [Collate] check box on [Paper/Output] on [Advanced...] on the [Paper/ Quality] tab in the Printing Preferences dialog box.
• Mac OS
The [Collate] check box in the print dialog box.
• Mac OS X
The [Collate] check box on [Copies & Pages] in the printer dialog box.
The following table shows the tabs or menus where you can select this function.
Windows 95 / 98 / Me

[Collate:]on the [Setup] tab.

Windows 2000, Windows XP

[Collate:] on [Printer Features] on [Advanced...] on the [Paper/Quality] tab in the Printing Preferences dialog box.

Windows NT 4.0

[Collate:] on [Printer Features] on [Document Options] on the
[Advanced] tab in the Document Defaults dialog box.

Mac OS

[Collate:] on [Printer Specific Options] in the print dialog
box.

Mac OS X

[Collate:] on the [Feature 1] tab on [Printer Feature] in the
printer dialog box.

3
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Paper Type
Use this to select the paper type.
The following table shows the tabs or menus where you can select this function.

3

Windows 95 / 98 / Me

[Type:] on the [Paper] tab.

Windows 2000 / XP,
Windows Server 2003

[Media:] on the [Paper/Quality] tab in the Printing Preference dialog box.

Windows NT 4.0

[Paper/Output] on the [Advanced] tab in the Document Defaults dialog box.

Mac OS

[Paper Type:] on [Printer Specific Options] in the print dialog
box.

Mac OS X

[Paper Type] on the [Features x] tab on [Printer Features] in
the print dialog box.

Reference
For details about the media type supported by this machine, see General Setting Guide.

Destination Tray
The following table shows where you can select this function.
Windows 95 / 98 / Me

[Output Tray:] in the [Paper] tab.

Windows 2000 / XP,
Windows Server 2003

[Destination] in [Printer Features] on [Advanced...] on the [Paper/Quality] or [Layout] tab.

Windows NT 4.0

[Destination] in [Printer Features] on [Document Options] on
the [Advanced] tab.

Mac OS

[Destination] in [Printer Specific Options] in the print dialog
box.

Mac OS X

[Destination]on the [Features x] tab in [Printer Features] in
the print dialog box.

Reference
For details about the destination tray supported by this machine, see General
Setting Guide.
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Staple
Use this function to staple sheets of printed paper together.
Limitation
❒ When stapling, use the finisher option. See General Setting Guide or Printer Reference.
Note
❒ The stapling location might differ depending on the orientation of the machine set in the printer and the orientation of the data to be printed. For details, see Printer Reference.
The following table shows where you can select this function.
Windows 95 / 98 / Me

[Staple:] on the [Setup] tab.

Windows 2000 / XP,
Windows Server 2003

[Staple:] in [Printer Features] on [Advanced...] on the [Paper/Quality] or [Layout] tab.

Windows NT 4.0

[Staple:] in [Printer Features] on [Document Options] on the
[Advanced] tab.

Mac OS

[Staple:] in [Printer Specific Options] in the print dialog box.

Mac OS X

[Staple:] on the [Features x] tab in [Printer Features] in the
print dialog box.

3

Punch
Use this function to punch holes in the printed documents.
Limitation
❒ When punching holes, use the finisher option. See Printer Reference.
Note
❒ Punch positions and the number of punch holes that are available will change
depending on the type of finisher, the original's orientation, and the printing
paper size and orientation. For details, see Printer Reference.
The following table shows where you can select this function.
Windows 95 / 98 / Me

[Punch:] on the [Setup] tab.

Windows 2000 / XP,
Windows Server 2003

[Punch:] in [Printer Features] on [Advanced...] on the [Paper/Quality] or [Layout] tab.

Windows NT 4.0

[Punch:] in [Printer Features] on [Document Options] on the
[Advanced] tab.

Mac OS

[Punch:] in [Printer Specific Options] in the print dialog box.

Mac OS X

[Punch:] on the [Features x] tab in[Printer Features] in the
print dialog box.
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Watermark
Set the Watermark function.
Note
❒ When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Windows
2000 / XP, Windows Server 2003, and Windows NT 4.0.

3

Windows 2000 / XP,
Windows Server 2003

[Watermark:] on [Printer Features] on [Advanced...] on the
[Paper/Quality] or [Layout] tab in the Printing Preferences
dialog box.

Windows NT 4.0

[Watermark:] on [Printer Features] on [Document Options] on
the [Advanced] tab in the Document Defaults dialog box.

Watermark Text
Select the Watermark Text type.
Note
❒ When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Windows
2000 / XP, Windows Server 2003, and Windows NT 4.0.
Windows 2000 / XP,
Windows Server 2003

[Watermark Text:] on [Printer Features] on [Advanced...] on
the [Paper/Quality] or [Layout] tab in the Printing Preferences dialog box.

Windows NT 4.0

[Watermark Text:] on [Printer Features] on [Document Options] on the [Advanced] tab in the Document Defaults dialog box.

Watermark Font
Select the Watermark Font type.
Note
❒ When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Windows
2000 / XP, Windows Server 2003, and Windows NT 4.0.
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Windows 2000 / XP,
Windows Server 2003

[Watermark Font:] on [Printer Features] on [Advanced...] on
the [Paper/Quality] or [Layout] tab in the Printing Preferences dialog box.

Windows NT 4.0

[Watermark Font:] on [Printer Features] on [Document Options] on the [Advanced] tab in the Document Defaults dialog box.
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Watermark Size
Select the Watermark Size size.
Note
❒ When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Windows
2000 / XP, Windows Server 2003, and Windows NT 4.0.
Windows 2000 / XP,
Windows Server 2003

[Watermark Size:] on [Printer Features] on [Advanced...] on
the [Paper/Quality] or [Layout] tab in the Printing Preferences dialog box.

Windows NT 4.0

[Watermark Size:] on [Printer Features] on [Document Options] on the [Advanced] tab in the Document Defaults dialog box.

3

Watermark Angle
Select the Watermark angle.
Limitation
❒ This item is only for portrait, not for landscape.
Note
❒ When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Windows
2000 / XP, Windows Server 2003, and Windows NT 4.0.
Windows 2000 / XP,
Windows Server 2003

[Watermark Angle:] on [Printer Features] on [Advanced...] on
the [Paper/Quality] or [Layout] tab in the Printing Preferences dialog box.

Windows NT 4.0

[Watermark Angle:] on [Printer Features] on [Document Options] on the [Advanced] tab in the Document Defaults dialog box.
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Watermark Style
Select the Watermark style.
Note
❒ When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS X,
see the printer driver Help. The following explains the procedure for Windows
2000 / XP, Windows Server 2003, and Windows NT 4.0.

3

Windows 2000 / XP,
Windows Server 2003

[Watermark Style:] on [Printer Features] on [Advanced...] on
the [Paper/Quality] or [Layout] tab in the Printing Preferences dialog box.

Windows NT 4.0

[Watermark Style:] on [Printer Features] on [Document Options] on the [Advanced] tab in the Document Defaults dialog box.

Dithering
Use this to set the Image Rendering mode.
The following table shows the tabs or menus where you can select this function.
Windows 95 / 98 / Me

[Dithering:] on the [Print Quality] tab.

Windows 2000 / XP,
Windows Server 2003

[Dithering:] on [Printer Features] on [Advanced...] on the [Paper/Quality] or [Layout] tab in the Printing Preferences dialog box.

Windows NT 4.0

[Dithering:] on [Document Options] on the [Advanced] tab in
the Document Defaults dialog box.

Mac OS

[Dithering:] on [Printer Specific Options] in the print dialog
box.

Mac OS X

[Dithering:] on the [Features x] tab on [Printer Features] in
the print dialog box.

You can select the following items:

❖ Auto
Use this setting to configure the best dithering method automatically depending on the appearance of the document to be printed.
❖ Photographic
Performs dithering using an appropriate pattern for photographs.
❖ Text
Performs dithering using an appropriate pattern for text.
❖ User SettingImage Smoothing
Use this setting to print images set in half tone in your application.
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Image Smoothing
Use this to select the image smoothing type.
The following table shows the tabs or menus where you can select this function.
Windows 95 / 98 / Me

[Image Smoothing] on the [Print Quality] tab.

Windows 2000 / XP,
Windows Server 2003

[Image Smoothing] on [Printer Features] on [Advanced...] on
the [Paper/Quality] or [Layout]tab in the Printing Preferences dialog box.

Windows NT 4.0

[Image Smoothing] on [Printer Features] on [Document Options] on the [Advanced] tab in the Document Defaults dialog box.

Mac OS

[Image Smoothing] on [Printer Specific Options] in the print
dialog box.

Mac OS X

[Image Smoothing] on the [Features x] tab on [Printer Features] in the print dialog box.

3

❖ Off
Disables image smoothing.
❖ On
Performs image smoothing unconditionally.
❖ Auto
Performs image smoothing automatically for images that have a resolution
less than 25% of supported printer resolution.
❖ Less than 90 ppi - Less than 300 ppi
Performs image smoothing only when the image has an image resolution
(pixels per inch) less than the respective value you have selected in the list.
Note
❒ When [Auto] is selected, data processing may take a long time.

❒ When Image Smoothing is used for a mask image, this function may have an
undesired effect on the print result.

109

Using PostScript 3

3

110

4. Printer Utility for Mac
By using Printer Utility for Mac, you can download fonts, change the name of
the printer and so on.
Limitation
❒ If a Macintosh and printer are connected by USB, you cannot use Printer Utility for Mac.
Note
❒ Printer Utility for Mac is included on the CD-ROM labeled “Printer Drivers
and Utilities”.

❒ Printer Utility for Mac requires Mac OS 8.1 or higher. (Mac OS X Classic environment is supported.)
❒ Printer Utility for Mac cannot use Mac OS X (native mode).

Installing Printer Utility for Mac
Follow these steps to install Printer Utility for Mac on the machine.

A Start the Mac OS.
B Insert the CD-ROM into the CD-ROM drive.
The CD-ROM icon appears.

C Double-click the CD-ROM icon.
The contents of the CD-ROM appear.

D Double-click the [Mac OS] folder.
Note
❒ Under Mac OS X, double-click the [Mac OS X] folder.

E Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Printer Utility for Mac] file, and then drop it into the Macintosh hard disk.

F Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.
Printer Utility for Mac is installed.
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Starting Printer Utility for Mac
The following instructions describe how to start Printer Utility for Mac.

Mac OS
Important
❒ Before starting Printer Utility for Mac, make sure the printer is selected in
[Chooser] on the Apple menu.

A Double-click the Printer Utility for Mac icon.
The [Printer Utility for Mac] dialog box appears.

4

B Click [OK].
Printer Utility for Mac will take a few seconds to start.

Mac OS X

A Double-click the Printer Utility for Mac icon.
The [Printer Utility for Mac] dialog box appears.

B Click [OK].
C In the [Available Printers:] box, select the printer you want to use.
Note
❒ If you change zones, select a name from [Available Network Zones:].

❒ Click [Choose Printer...] on the Printer Utility for Mac menu if you want to
change the printer.

D Select the printer you want to use.
Printer Utility for Mac will take a few seconds to start.

E Click [Choose].
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Printer Utility for Mac Functions
Printer Utility for Mac functions are described below.

❖ File menu
• [Download PS Fonts...]
Download fonts (PostScript Type 1) to the printer. See p.114 “Downloading PS Fonts”.
• [Display Printer's Fonts...]
Display and delete the fonts in printer memory and the printer's hard disk
drive. See p.115 “Displaying Printer's Fonts”.
• [Initialize Printer's Disk...]
Initialize the printer's hard disk drive. See p.116 “Initializing the Printer
Disk”.
• [Page Setup...]
Set up the paper size to print “Printer Font Catalog” and “Printer Font
Sample”. See p.116 “Page Setup”.
• [Print Fonts Catalog...]
Print the names of available fonts. See p.116 “Printing Fonts Catalog”.
• [Print Fonts Sample...]
Print a sample of fonts. See p.117 “Printing Fonts Sample”.
• [Rename Printer...]
Change the printer's name when viewed via Appletalk. See p.117 “Renaming the Printer”.
• [Restart Printer]
Restart the printer. See p.118 “Restarting the Printer”.

4

❖ Utility menu
• [Download PostScript File...]
Download a PostScript file. See p.118 “Downloading PostScript Files”.
• [Select Zone...]
Change the zone to which the printer belongs to via Appletalk. See p.119
“Selecting the Zone”.
• [Display Printer Status...]
Display the status of the printer. See p.120 “Displaying the Printer Status”.
• [Launch Dialogue Console...]
Create and edit a PostScript file, and then download it to the printer. See
p.120 “Launching the Dialogue Console”.
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Downloading PS Fonts
You can download the PS fonts to the printer's memory or hard disk drive.
Important
❒ The following procedures to download the fonts assume that you are a system
administrator. If you are not, be sure to consult your system administrator.

❒ If the printer restarts, all the printer settings return to their defaults.
❒ Confirm that a Mac OS and the printer are connected with Appletalk.
Note
❒ Some fonts cannot be downloaded.

❒ Before downloading, read the documentation about the fonts you want to use.

4

A Select [Download PS Fonts...] on the [File] menu.
B Click [Add to list].
The dialog box to select fonts appears.

C Click to select the desired font files, and then click [Open].
The list of selectable font names appears.

D After adding all the fonts you want to download, click [OK].
The dialog box of selected fonts to download appears.

E Click [Download].
The fonts begin to download, and the download status is shown.
Important
❒ During the download, do not turn off the power switch, operate the panel
or open or close the cover.

F When the completion message appears, click [OK].
G Click [Cancel].
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Displaying Printer's Fonts
You can display the available fonts currently downloaded to the printer. Fonts
in the printer's memory and hard disk drive can be displayed.
Note
❒ The fonts displayed in italics are the default fonts.

A Select [Display Printer's Fonts...] on the [File] menu.
A dialog box appears.

B Select [Printer's memory] or [Printer's disk].
C Click [OK].

4

Deleting Fonts
You can delete fonts from the printer's memory or hard disk drive.

A Select [Display Printer's fonts] on the [File] menu.
A dialog box appears.

B Select [Printer's memory] or [Printer's disk].
C Select the fonts you want to delete.
Limitation
❒ You cannot delete the fonts displayed in italic.

D Click [Delete].
A confirmation message appears.

E Confirm the fonts you want to delete and the printer name from which you
want to delete the fonts.

F Click [Continue], and then click [OK].
G Click [OK].
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Initializing the Printer Disk
When initializing the printer's hard disk drive, all the fonts downloaded to the
printer's hard disk drive are deleted. Before initializing, be sure to check the
fonts on the hard disk drive.
Important
❒ When initializing the printer's hard disk drive from the operation panel, all of
the data on the printer's hard disk drive is deleted. Before initializing, be sure
to check the data on the hard disk drive.

A Select [Initialize Printer's Disk...] on the [File] menu.
The confirmation message appears.

4

Note
❒ To cancel initialization, click [Cancel].

B Click [Execute].
Initializing starts.
Important
❒ Do not turn off the power switch until initializing is completed, otherwise
the hard disk drive might be damaged.

C When the completion message appears, click [OK].
Page Setup
You can set the paper size on which to print “Print Fonts Catalogue” and “Prints
Fonts Sample”.

A Select [Page Setup...] on the [File] menu.
B Choose the paper size.
Printing Fonts Catalog
Print the names of fonts available on the printer.
Note
❒ The paper selected under [Page Setup] is used.

A Select [Print Fonts Catalogue] on the [File] menu.
B Click [Print].
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Printing Fonts Sample
You can print samples of fonts downloaded to the hard disk drive or memory.
Note
❒ Print by using the paper selected on [Page Setup].

A Select [Print Fonts Sample...] on the [File] menu.
B Click [Print].
Renaming the Printer
You can change the printer name displayed under Appletalk. If you connect several printers on the network, assign different names so you can identify them. If
several printers have the same name, a digit appears next to the printer name in
[Chooser].

4

Important
❒ You can enter up to 31 digits and letters.
❒ Do not use symbols, for example “*”, “:”, “=”, “@”, “~”.

Mac OS

A On the [File] menu, click [Rename Printer...].
B In the [New Name:] filed enter a new name.
C Click [Rename].
The printer name is changed.

D Click [OK].
E On the Apple menu, click [Chooser].
F Click the [AdobePS] icon.
G Select the printer whose name you changed, and then close the [Chooser] dialog box.

Note
❒ If there are several Appletalk zones, select the zone the machine belongs to.

Mac OS X

A On the [File] menu, click [Rename Printer...].
B In the [New Name:] filed enter a new name.
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C Click [Rename].
The printer name is changed.

D Click [OK].
E On the [Printer Utility for Mac] menu, click [Choose Printer...].
F In the [Available Network Zones:] list, select the zone for the Macintosh in use.
G In the [Available Printers:] list, select the printer whose name you changed,
and then click [Choose].

Restarting the Printer

4

You can restart the printer.

A Select [Restart Printer] on the [File] menu.
B Confirm the message that appears on the screen, and then click [Restart].
The printer restarts.
Note
❒ The fonts that you downloaded in the printer's memory will be deleted.
❒ If the printer restarts, all the printer settings return to their defaults.

Downloading PostScript Files
You can download a Postscript file to the printer.

A Select [Download PostScript File...] on the [Utility] menu.
B Select the file name to download and click the file name, and then click
[Open].

C Type the log file name, and then click [Save...].
The selected file is downloaded.
Note
❒ Errors are recorded in the log file.
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Selecting the Zone
You can change the zone to which the printer belongs under Appletalk.
Important
❒ Confirm that a Macintosh and printer are connected with Appletalk.

Mac OS

A On the [Utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

B Select the zone in which you want to locate the printer, and then click

4

[Change].
A confirmation message appears.

C Click [Continue].
A confirmation message appears.

D Click [OK].
E On the Apple menu, click [Chooser].
F Click the [AdobePS] icon.
G In the [Appletalk zone:] list, select the zone you changed.
H In the [Select a PostScript Printer:] list, select the printer you want to use.
I Close the [Chooser] dialog box.
Mac OS X

A On the [Utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

B Select the zone which you want to locate the printer in, and then click
[Change].
A confirmation message appears.

C Click [Continue].
A confirmation message appears.

D Click [OK].
E On the [Printer Utility for Mac] menu, click [Choose Printer...].
F In the [Available Network Zones:] list, select the zone you changed.
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G In the [Available Printers:] list, select the model of printer in use, and then
click [Choose].

Displaying the Printer Status
You can display and confirm the current status of the printer.

A Select [Display Printer Status...] on the [Utility] menu.
The current status of the printer appears.

B Confirm the current status of the printer.
You can confirm the memory capacity, the VM (Virtual Memory) space, the
hard disk drive status and available space on the hard disk drive. You can
also confirm the zone to which the printer belongs to.

4

C Click [OK].
Launching the Dialogue Console
You can create and edit a PostScript file for printing, and then download it to the
printer.
Important
❒ “Launch Dialogue Console” is recommended for users with an understanding of PostScript.

❒ Do not download any file other than PostScript files to the printer.
❒ “Launch Dialogue Console” must be used at your own responsibility.

A Select [Launch Dialogue Console...] on the [Utility] menu.
Open the editing screen. The Dialogue Console menu bar appears.

B Type the PostScript command in the editor screen.
Note
❒ To edit a PostScript file, select [Open] on the [File] menu to open it.

❒ You can search or replace a character string by using the [Search] menu.

C After editing the PostScript file, select [Download Top Window] on [Console]
menu to start printing.
The PostScript file is sent to the printer.

Note
❒ The [Reply from Printer] box opens, depending on the PostScript file you
sent.

D Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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